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Welcome . 1

Welcome to Demo Builder
Demo Builder provides an easy way to create tutorials, presentations or demonstrations that show how software and
systems work. Demo Builder's ease of use gives you the ability to create stunning, yet practical and professional
instructional videos. Demo Builder is the ideal tool for generating the demos you require to teach, train, or sell.
Demo Builder's simple interface was designed with the user in mind. Taking but a few minutes to become familiar with, it
provides users with everything needed to capture their activities onscreen in a running application. Further yet, it then allows one
to edit the recorded material and add elements such as voiceover narration, background music, breathtaking visual effects,
annotations, text, and countless other items designed to make your tutorials as efficient and effective as possible. Demo Builder
also supports events for a whole new level of interaction with the viewer, that is, you may add buttons clickable by the end
users, determine the behavior of your movie, jump to markers and do much more that you can possibly imagine !
View PDF Manual
Download a fully functional version of Demo Builder free for a 30day trial period.
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Home > Introduction
Introduction

Welcome to Demo Builder
Tanida Demo Builder creates interactive demonstrations and software simulations in Flash format by taking a series of
screenshots of a running application. It offers a simple, convenient and fast way to build professional flash demos/tutorials in just
a few minutes  No programming knowledge required!
This guide is designed to introduce you to using Demo Builder, all of its features, functions and tools. The guidelines in this help
file will take you through the features of the application and lead you through the process of creating a functional tutorial/demo.
The picture quality taken by Demo Builder is outstanding and the visual editing available lets you quickly incorporate unlimited
detail in your demonstrations.

Overview

System Requirements

See also
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Home > Introduction > Overview
Overview
Demo Builder is a powerful tool that allows you to create professional quality demos and tutorials with no programming
knowledge. There are no complicated interfaces and your demonstration or presentation can be made in a matter of minutes!
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How Does Demo Builder Work?
Demo Builder works by taking a series of screenshots of a running application. It records the actions being taken on the
application and so is able to demonstrate a simulation of these actions. Each screenshot taken by Demo Builder constitutes a
'Scene' that can then be edited to suit your required demo/tutorial.
Starting with Demo Builder 6, users will be able to take fullmotion recordings. That is, no longer will you be limited to taking
screenshots of the buttons clicked and the keys pressed in the application you are showcasing. Using this new feature you can
take fullmotion recordings that result in smooth, fluid demonstrations able to showcase everything from drag and drop
operations, to window resizing, and real cursor movements easier than ever.
After recording a running application and the actions taken on that application, employ Demo Builder's 'Editing Window' to add
specific details, annotations and visual aids to your movie with the use of 'Objects' and the manipulation of your tutorial's time
sequencing.
How Easy and Flexible!
Demo Builder is extremely flexible and easy to use. The Editing tools available allow total control of the scene's behaviour and all
visual aids and objects within that scene.

See also
System Requirements

Home > Introduction > System Requirements
System Requirements
Minimum system configuration
Windows 2000/XP/2003/Vista/7/8/8.1/10
DirectX 9
Intel P4, Intel Centrino, Intel Xeon, or Intel Core Duo (or compatible)
512+ MB RAM (1GB Recommended)
800x600 minimum screen resolution (1024x768 recommended)
See also
Overview
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Home > Create new movie
Create new movie
In the StartUp Screen locate the column titled 'Create New Movie'. You have the following options :
Blank
Record the screen
Import a series of images
Import Video

Blank

Record the screen

Import Images

Import Video

See also
Welcome
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Home > Create new movie > Blank
Blank
Create a movie containing a single blank scene.
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1

From the StartUp screen select 'Blank'

2

Select your preferred size for the Movie from preset sizes or manually enter required 'Width' and 'Height'

3

Select a 'Background Color'

4

Finally, click 'OK' at the bottom of the menu

See also
Record the screen

Import Images

Import Video

Home > Create new movie > Record the screen
Record the screen
Use the full motion recording method while you demonstrate your application or use the screenshot method to take a series of
screenshots of your application.
See also
Blank

Import Images

Import Video

Home > Create new movie > Import Images
Import Images
Create a movie from a series of existing images on your system.
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1

From the StartUp screen select 'Import Images' to browse for images on your disk or hard drive

2

Click 'Open' (the folder shaped icon) to import an image into the wizard. Repeat this process for every image you need
to insert into your movie.

3

The image's title and size is shown in the top left corner of the wizard.

4

The 'Remove' button is enabled when there is at least one image selected. This is shaped as an eraser.

5

Click 'Finish' and the new image(s) will be inserted as screenshot(s) in your movie. For each image you insert, a new
scene is created in your movie.

See also
Blank

Record the screen

Import Video

Home > Create new movie > Import Video
Import Video
Create a movie from an existing Video (avi, mpeg ...etc.) presentation.
1

From the StartUp screen select 'Import Video'

2

When you create a new movie by importing a Video file, it is imported as an entire scene, and not as an object that can
db11
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be controlled within a scene. Select the Video file you wish to import from your hard drive by clicking the 'Browse'
button
3

Once you click the Browse button and select your file, two options will show up :
Import Audio
Check this option in order to import audio from the file
Frame Rate
Initially, the frame rate is set to the original number of frames per second of the video file. To decrease the size of
the exported SWF file, you can decrease the number of frames per second captured by Demo Builder from your
video file.

4

Click Finish

See also
Blank

Record the screen

Import Images
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Home > Record the screen
Record the screen
From the startup screen select 'Record the Screen'. Next, a 'Wizard' (see below) appears allowing you to customize your
settings and start recording. Change the recording settings as necessary.
Demo Builder only captures activities within the red markings of the settings wizard. You can extend the size of the screen
capture by clicking on the edges of the screen marker and manually dragging these to give your required screen capture size.
Select the recording method that best caters to your needs. Two methods are available: Take Screen Shots and FullMotion
Recording .
Similarly, you have the ability to record voiceover narration at capture time. Please note that you also have the ability add
voiceover narration later, during the editing phase. For example, you may narrate the Timeline using the voiceover narration
feature in the Editing Window.

1

Record
Click the Record button to start taking screenshots (or activate FullMotion Recording) of your actions on a running
application. Demo builder starts recording. An icon sits on your taskbar system tray and blinks red to denote that
recording is in progress.

2

End Recording
To end the recording session leftclick on the icon. Demo Builder will stop recording, compile and import screensshots
(or your fullmotion recording), and then display the movie as a series of scenes in the Movie Window.

Click the Options button to change recording options.
1

Camera sound audible during recording
Available only when choosing the 'Take Screenshots' method.

2

Insert Cursors
Select this option to insert cursor motion into your movie.
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3

Hide system tray icon
If you are recording your entire screen and do not want the Demo Builder system tray icon to display during recording,
simply select this option.

4

Hotkeys
You can set specific hotkeys for pausing/resuming the recording, as well as for ending the recording (in the case where
you have hidden the system tray icon and cannot stop the recording by clicking on this).

Take screen shots

FullMotion Recording

Help me choose
See also
Welcome

Introduction

Create new movie

Movie
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Home > Record the screen > Take screen shots
Take screen shots
Take screenshots of a running application.
1

Enable Auto Recording
When enabled, Demo Builder automatically takes screenshots every time an action is taken using the mouse or the
keyboard.

2

Record Keystrokes
This option specifies whether or not to have Demo Builder take screenshots when keyboard actions are undertaken.

3

Hotkey
To manually take screenshots of an application, uncheck 'AutoRecording', fit Demo Builder's screen capture wizard to
the desired application's window and then press 'PRINT SCREEN' to take screenshots.
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See also
FullMotion Recording

Help me choose

Home > Record the screen > FullMotion Recording
FullMotion Recording
Record screen activity in fullmotion video.
1

Capture Rate
Set how many frames per second are to be captured, from 1 to 20. Note that although a higher frames per second rate
will result in a larger file size, this will also make the playback motion smoother.

2

Enable AutoMark
Selecting this option will automatically place Marks within the scenes during recording
Marks are useful for:
Jumping to a certain location within a movie/scene, Executing (or not) a certain action, Adding balloons (if the mark was
added automatically during recording)
You do not have to add marks automatically during recording, but it is an available option. You can always add (or
delete) marks manually in the Editing Window, after the recording has been taken.

3

Capture semitransparent windows
Select this option if you will be recording an application or software that has semitransparent windows. This will ensure
proper recording of such windows.(i.e. 'drag and drop' demonstrations )
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See also
Take screen shots

Help me choose

Home > Record the screen > Help me choose
Help me choose
There are two methods available to take a recording: 'Taking Screenshots' and 'Full Motion Recording'.
When employing the 'Taking Screenshots' method, Demo Builder captures images only when a change occurs on the screen
you are recording. You have the option of also manually forcing a screenshot, but other than that, there are relatively few
screenshots needed to make a recording using this method. When you finish recording, an Editing Window appears allowing you
to add notes, balloons, cursor movements and extra images to each screenshot. Each screenshot can remain open or active for
as long as you need, that is, so all activity on that screenshot can be performed.
When using the 'Full Motion Recording' method, Demo Builder continually takes screenshots at preset intervals (anywhere
from 1 to 20 frames per second) which results in a much smoother presentation.
Full Motion Recording : Recommended for applications where changes in the screen happen quickly and for instances where
you want to capture such things as drag and drop, screen resizing, animated GIFs, or even full motion movies. The result is a
more fluid presentation, but the resulting file size is larger.
Taking Screenshots: Recommended for applications where full motion recording is not necessary. The screenshot method
results in small file sizes that open quickly. The appearance and disappearance of all cursor movements, notes, balloons and
other objects is set so that the resulting recording still relays the effect of a video presentation.
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See also
Take screen shots

FullMotion Recording
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Home > Movie
Movie
Movie properties can be found in the Thumbnails View. In the Title tab you can edit your movie’s publisher information (e.g.
author, title, etc.). Change your movie’s size dimension in the Size tab; you can also edit this option in the startup screen when
you create a new movie. In the Background tab you can select or import background images for your movie. The Startend tab
allows you to edit the way your movie is loaded (e.g. select Ask Password to prompt viewers for a password) and the way your
movie ends (e.g. enable your movie to take the viewer to a URL). You can select player or menu bars from the Navigation tab,
which allow the viewer to navigate the movie while it plays; player bars can also display publisher information about the movie.
The Watermark tab allows you to add a customized watermark and the Audio tab allows you to add audio files.
Set the following properties and options for Movie:

1

Name
The name property allows you to specify the movie's name, its author's name, a company's name, Email address,
website and a brief description of the demo, tutorial or movie.

2

Info
Author, Company, EMail, Website and movie description. Your personal information will be displayed in the 'Info' box
should a player bar be added to the movie
Learn more...

3

Size
The size property allows you to specify a new size (in screen pixels) for your movie.

4

Background
Select a personal background color, gradient or wallpaper image for your movie.
Learn more
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5

StartEnd
The startend property is used to specify the load behavior of the movie and the actions to be taken at the end of the
movie.

6

Navigation
Add a player bar or menu bar to your movie.

7

Watermark
Add a custom watermark (or logo) to all scenes of your movie.
Learn more...
A watermark can be altered in terms of physical location, within all scenes,
and opacity. You can optionally make it 'clickable' so that it hyperlinks to a
webpage of your choosing.
Watermarks can be used to automatically insert a company logo, phone
number, or email address in the same location across all scenes within your
movie.
Use it as a branding tool, but also to protect your work from plagiarism.

8

Background Audio
Add background audio effects, including voice narration, to your movie by importing existing sound files on your system
or by recording new ones using Demo Builder.

Resize your movie

StartEnd
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Add menu bar

Add player bar

Link your movies

Background audio

Translate your movie
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Home > Movie > Resize your movie
Resize your movie
Select the Size option from the movie properties panel in order to specify the new dimensions of your movie.
1

Width x Height
Click the dropdown box and choose a preset size(Web, CD, Blog, iPhone, HD) or select the Custom menu item to
enter custom dimensions.

2

Anchor
Click an 'Anchor' button to specify which sides of the canvas Demo Builder should add to or delete from.

3

Original and Design labels
Click on the 'Original Size' label to restore the movie to its original size(the dimensions at capture time). Click on the
'Design Size' label to set the movie's output size equal to its size during editing(this feature is only applicable when the
designtime scale is less than 100%).
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Note: By default, the center anchor is selected, indicating that changes to the size of the canvas are made on all sides.

See also
StartEnd

Add menu bar

Add player bar

Link your movies

Background audio

Translate your movie

Home > Movie > StartEnd
StartEnd
The StartEnd property is used to specify the load behaviour of the movie and the actions to be taken at the end of the movie.
1

Preloader
Customize the image to be displayed, optionally, as the movie loads. You can also adjust the load percentage that must
be reached before the movie begins playing.

2

Show Play button
Add a 'Play' button at the beginning of your movie. The movie will only start playing when the 'Play' button is clicked.
Without a 'Play' button, the movie will start playing as soon as it is loaded  without asking for any confirmation from the
viewer.

3

Domain Lock
Tick the Domain Lock check box to restrict the accessibility of a movie to a specific domain (e.g mydomain.com).

4

Expiration Date
Add an expiration date to your movies so that these can't be played after a predetermined date. If users attempts to view
an expired movie, they will be redirected to a webpage or displayed text explaining the situation.

5

Ask Password
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Add password protection to your movies. This option allows you to create movies that will ask users for a password in
order to be able to view the movie.
6

At End Action
Add one of the following behaviors to the end of your movie : Stop Movie , Loop Movie, Close Movie, Go To URL,
Run EXE, Go To Movie, Execute JavaScript

7

Show Replay button
Add a 'Replay' button at the end of your movie by ticking this checkbox.

See also
Resize your movie

Add menu bar

Add player bar
Background audio

Link your movies
Translate your movie

Home > Movie > Add menu bar
Add menu bar
Add an interactive menu at the top of your movie to link additional content or to create a table of contents for large projects.
You may add any number of menu and submenu items. Menu items are displayed across the top of the movie, while sub
menu items are displayed as dropdown choices below their respective parent menu item.
Each menu item can be renamed to suit your needs and may also have an action associated with it. You can use menu items to
jump to specific locations within your movie (marks and/or scenes), jump to new movies, open a web page, run an EXE file,
send an email or close the movie. The Menu Bar is therefore a handy feature for creating quick and easy links to other parts of
your movie, or if you are building a large library of movies. It may also be exported and imported into any other movies you
would like it added to.
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See also
Resize your movie

StartEnd

Add player bar
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Home > Movie > Add player bar
Add player bar
Used to control basic playback tasks such as playing, pausing, stopping, rewinding, and forwarding.
Its 'Seek' feature indicates the playback progress of the movie. When the Seek feature is available, your endusers can drag the
progress indicator to any point in the movie to start playback from there. This also shows which scene is being viewed in relation
to the total number of scenes in the movie.
The Player Bar also includes an 'Audio On/Off' button to 'mute' sound during playback, if desired, at any point. The Player Bar
now also supports the following keyboard shortcuts :
Back to First
Scene
Pause/Play

Home key
Space bar

Previous Scene

Left Arrow key

Next Scene

Right Arrow key

Audio On/Off

M key

Info

I key
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See also
Resize your movie

StartEnd
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Home > Movie > Link your movies
Link your movies
We strongly recommend breaking up your demonstration or tutorial into individual 'chapters' and creating separate, shorter
movies for each of these instead of a single, very long tutorial. These individual movies can be 'linked' together to give the
appearance of a single movie if desired.
This can be achieved as follows :
1

Open the first movie in 'Thumbnail View'.

2

From the 'Movie Properties' panel, select the 'Start  End' button and click on the 'At end' dropdown menu.

3

Select Go To Movie or Go To URL from the list of available actions and then choose the next movie file (or chapter) in
the sequence. (e.g. http://mydomain.com/movie2.swf or http://mydomain.com/movie2.html).

4

Repeat the above steps for each individual chapter movie file in your sequence.
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Note: This option is only available for movies exported as a Flash Movie (*.swf) or H264(*.mp4).

See also
Resize your movie

StartEnd

Add menu bar

Add player bar

Background audio

Translate your movie

Home > Movie > Background audio
Background audio
Add audio effects, including voice narration, to your movie by importing existing sound files or recording new ones using Demo
Builder. You can add background audio to your movie in a number of ways :
Record voiceover narration while initially capturing your screenshots (at capture time).
Record voiceover narration while previewing and editing your movie by selecting the 'Background Audio' button in the
properties panel and then clicking on the 'Record' (+) button to record your voiceover narration.
Likewise, you can also add background audio to your movie by Importing *.wav and *.mp3 files, either from your
computer, a network drive or from Demo Builder's builtin 'Audio Collection'.
When an Audio effect is included in the movie, the background audio properties expand to include additional properties.
1

Loop
Check the Loop box to have this audio clip repeat continuously throughout your movie.

2

Fade In/Out
Use these to add fade effects to your background audio. The music can be faded in or out in 'short', 'medium' or 'long'
modes, or you can choose 'none' to have audio play without a fade effect.

3

Volume
Use this to adjust the volume of your background audio for scenes with added background audio. For example, if you
insert music as the movie's background audio and then also insert voiceover narration in one of your scenes, this
property allows you to lower the volume of the movie's background audio so that the voiceover is dominant during this
scene.
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See also
Resize your movie

StartEnd
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Home > Movie > Translate your movie
Translate your movie
Translate your movie's text and distribute these internationally !
The Localize Wizard allows you to update the language of your movies for international distribution by exporting your movie's
caption text (found in balloons, notes, text boxes) to a MS Word document (*.doc). Here, you translate the text in the desired
language and then import it back to update your movie with the help of the 'Localize Wizard'. Start by selecting Localize... from
the Demo Builder 'File' menu to bring up the Localize Wizard and then follow these steps :
1

Select the desired Operation  either Export or Import.

2

Enter or select the name and location of the export file that will contain the text to be 'localized'.

3

Open MS Word and update the second column of the document generated to translate your original text into the
desired language.

4

Save the updated MS Word document.

5

Run the Localize Wizard in Demo Builder again, but this time Import the translated text back into your movie.

6

(Re)Build your movie.
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Note: Please note that Microsoft Word 2003 or later must be installed on your machine.

See also
Resize your movie
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Home > Scenes
Scenes
A scene’s properties can be edited once it is opened in Design View. In the Title tab you can change the scene’s name, toggle
its visibility by clicking the eye icon and add notes about the scene. The Background tab allows you to add a customizable
border and the Position tab allows you to rotate, angle and scale the entire scene. The Keystroke tab is only available in scenes
made using screen shots; here you can toggle keystroke audio or remove it. In the End of Scene Action tab you can edit the way
the scene ends (e.g. continue, go to scene, go to URL, etc.). The Audio tab allows you to add existing or record new audio.
Set the following properties and options for Scenes :

1

Name
The default name for a scene is 'Scene X' ('Scene 1', 'Scene 2', 'Scene 3', and so onward), and this is visible in the name
property of the movie. You can change a scene's name by deleting the default name and typing in another one. Ensure the
scene is selected before attempting to change its name property.

2

Visibility
If Visibility is ON, then the scene will be included in the movie when this is Previewed or Exported.

3

Note
Insert desired details about your scene. These will appear only if the movie is exported as either 'Image Files' or 'Word
Document' format.

4

Character
Use this option to add a Character to your scene and animate it with a variety of movements (walking, pointing, head and
eye movement, etc.) and Speech. Please note that due to Flash limitations characters are not exported in Flash format.

5

Background
Select a border, the color of this border and then customize the width and padding of this border. You may also choose
to add a reflection and drop shadow effect.
Learn more...
If the image is of substantial size (eg. 1000x1000), please be aware that the
reflection effect may slowdown the playback of the movie when it is exported in
Flash format.

6

Position
Select the scene's initial rotational angles, scale and transparency. These will be retained until a Transformation is added.
These values may only be modified by moving the Playhead to the beginning of the scene and using the mouse.
db11
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Learn more
Click the Eraser button to clear all values.
Select 'Apply to all scenes' if you would like to retain the same values for all
scenes.
Clicking the individual labels will display a menu which offers the option to either
reset the parameter or copy this parameter's value to all Transformations.

7

Keystroke
This option is visible only if you created your movie using the Take screen shots method.You can enable or disable the
typing sound by selecting the 'Mute' option. Also, you can choose to remove the keystroke from the scene.

8

End Of Scene Action
You can add the following actions at the end of a scene: Continue, Go To Scene, Go To Movie, Go To URL, Close
Movie, Run EXE or Execute JavaScript. The default action is 'Continue'.
Learn more...

9

Background Audio
Add audio clips to your scene by importing existing files or recording new ones using Demo Builder.
Learn more...
Click on the '+' sign to add audio or the '' sign to remove a
selected audio clip.
Click on the Audio Settings button (in the top right corner) to change
audio settings or to select and calibrate your audio input device.
Each individual audio clip can be edited to your needs. To do this,
click on the button next to the audio clip to be edited. The Audio
Clip Editor appears.
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Home > Scenes > Thumbnails View
Thumbnails View
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The 'Thumbnail View' section is the area in which all of the scenes of your movie are displayed. You may reorder, delete,
duplicate or merge scenes here.

See also
Quick preview
Insert additional scenes

Change order
Merge multiple scenes

Split a scene

Copy/Paste  different movies

Keystroke

Home > Scenes > Quick preview
Quick preview
Demo Builder offers you the possibility to preview your movie. To do this, select the 'scene' item, hold down the left mouse
button and drag horizontally in either directionan action that is similar to moving the Playhead along the Timeline. When the
effect is successfully triggered, a red line appears to denote the Playhead's position in the Timeline.

See also
Thumbnails View
Insert additional scenes
Split a scene
Keystroke

Change order
Merge multiple scenes
Copy/Paste  different movies
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Home > Scenes > Change order
Change order
Below are instructions on how to change the order of the scenes in your movie.
1

Go to Thumbnail View

2

Select the scene that you want to move.
You can select multiple scenes by holding down the CTRL key while clicking on each scene.

3

Drag the selection to a new location, as desired.

See also
Thumbnails View
Insert additional scenes

Quick preview
Merge multiple scenes

Split a scene
Keystroke

Copy/Paste  different movies

Home > Scenes > Insert additional scenes
Insert additional scenes
To add a new scene, go to Thumbnails View, click the 'Insert New Scenes' (+ sign) button and follow the steps depending on
what it is you wish to do.
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See also
Thumbnails View
Change order

Quick preview
Merge multiple scenes

Split a scene
Keystroke

Copy/Paste  different movies

Home > Scenes > Merge multiple scenes
Merge multiple scenes
You can merge multiple scenes into one scene with Demo Builder. To merge scenes together, in Thumbnail View, select all of
the scenes to be merged. You can select multiple scenes by holding down the CTRL key while clicking on each scene. Once all
desired scenes are selected, rightclick on one of the scenes, and select "Merge" from the resulting menu. The selected scenes
will be merged into one longer scene.
You cannot merge two differently sized scenes. For example, should you record a scene 800x600 in size and then also record a
scene 1024x768 in size, these two scenes can't be merged. Scenes must be corresponding in size. In this case, these must be
either both 800x600 or 1024x768 in size to be merged.
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Note: This operation cannot be undone.

See also
Thumbnails View

Quick preview

Change order
Split a scene

Insert additional scenes
Copy/Paste  different movies

Keystroke

Home > Scenes > Split a scene
Split a scene

To split a scene into two separate scenes, first drag the Playhead to the location in the Timeline where you wish the split to
occur. Then right click in the Timeline area and select "Split". The existing scene will be split at precisely the location where the
Playhead was located.
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Note: This operation cannot be undone.

See also
Thumbnails View
Change order

Quick preview
Insert additional scenes

Merge multiple scenes
Keystroke

Copy/Paste  different movies

Home > Scenes > Copy/Paste  different movies
Copy/Paste  different movies
In order to copy a scene(or scenes) from one movie into another, please follow these steps :
1

Open both movies.

2

From the Thumbnail View of the source movie, right click on the scene you want to copy and select Copy.
Select the destination movie from the movie panel on the left, right click in the Thumbnails area of the destination movie
and select Paste.

See also
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Thumbnails View
Change order

Quick preview
Insert additional scenes

Merge multiple scenes
Keystroke

Split a scene

Home > Scenes > Keystroke
Keystroke
The Keystroke object is only visible in the Timeline and not visible in the Objects Panel of the movie's Editing Window. It
represents any keyboard actions taken during movie recording and is indicated in the Timeline as a 'Keystroke'.
How to Use the Keystroke Object (an Example)
1

Open your usual text editing application (e.g. NotePad, MS Word, WordPerfect, etc.)

2

Create a new movie and fit the screen capture area to the chosen text editing application.

3

Start recording and type a few characters in the text editing application.

4

Stop recording.

5

The movie's properties should display the scenes created for your movie.

6

Double click a scene to view its properties. In the Timeline, the type object is indicated.

7

Position
You can adjust the position of the type object within the Timeline by clicking, dragging and dropping it in the desired
location within the Timeline.

8

Typing Speed
Adjust the typing speed visible in your movie by clicking on the edge of the object and extending it to cover a longer or
shorter time period as necessary.

Keystroke's property panel

1

Mute
Enable or disable the typing sound.

2

Remove
Remove the keystroke from the scene. Note: This operation cannot be undone.

Note: The Keystroke's property panel is only visible when a scene is in editing mode and no other object is selected.

See also
Thumbnails View
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Change order

Insert additional scenes

Merge multiple scenes
Copy/Paste  different movies

Split a scene
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Home > Cursors
Cursors
Cursor properties can be edited in the Design View by clicking on the cursor object in the timeline or on the start or end point of
the cursor movement on the canvas. In the Title tab you can rename the cursor, the Pointer tab allows you to choose different
images to represent the cursor and the Scale tab allows you to change the cursor size. In the Highlight Effect tab you can toggle
a customizable circular highlight for the cursor. The Cursor Paths tab allows you to edit and smooth out the path the cursor
moves along; these paths are only visible during movie editing, they will not be visible once the movie is exported. In the
Click/Double Click Effect tab you can add an audio and visual click effect. The Align Cursors icons allow you to align cursors in
different scenes so that a new cursor path will start where the previous one ended.
Set the following properties and options for Cursors:

1

Name
The default name for a cursor object is 'Cursor X' ('Cursor 1', 'Cursor 2', 'Cursor 3', and so onward), and this is visible in
the name property of the movie. You can change a cursor's name by deleting the default name and typing in another one.
Ensure the cursor is selected before attempting to change its name property.

2

Pointer
There are several different images available to represent the cursor. Regardless of what the cursor looked like during
recording, you can change it to any of the available images.
Learn more...
The three options for changing the cursor's symbol are:
Movie shows all cursor images being used within your movie.
Current Theme contains cursor images with a similar theme to
the default cursor.
Custom gives you the option of selecting existing clipart from
Demo Builder, or browsing and inserting an image from disk.

3

Scale
Change the scale of the cursor.
Learn more...
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Click the leftmost cursor symbol to restore the cursor to its original size.
Click the second cursor symbol (rightmost) to double the size of the present cursor.
Check 'Apply to all cursors' to maintain the above scale for all cursors in the movie.

4

Highlight Effect
Draw a circle underneath the cursor symbol.
Learn more...
Select the checkbox to enable the highlight effect. Then you may choose a color, radius
and opacity.
Check 'Apply to all cursors' to maintain the above preferences for all cursors in the
movie.

5

Cursor paths
When you have a cursor motion in a scene, you have the option of setting that motion as a straight line, a concave arc, a
convex arc, or a completely custom motion. To create a straight or arc motion, simply select the appropriate icon.
However, creating a custom motion is more complex.
Learn more...

6

Click/DoubleClick effect
Effects are used to determine the sound and visual effect made by the cursor at clicking point. These icons can either be
selected (lit up) or not. If neither icon is selected, then there will be no sound effect (click or double click audio) or visual
cue at the ending of the cursor path.
Learn more...
Color
Sets the color of the click/double click effect.
Radius
The size of the click/double click effect.
Mute
Disables the sound effect.
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7

Align Cursors
There are two additional icons available, the "Cursor Align" icons. These icons align the cursor's position in one scene to
another cursor's position in the following or previous scene to give consistent flow to cursor movements from scene to
scene. These icons are only available if the action is possible. For example, if there is no cursor in the following scene,
then there will be no "Align Forward" icon. Also, if there is no cursor in the scene prior to the current one, then there will
be no "Align Backward" icon. These align icons are only available for the first and last cursors inserted in a scene.
Example...
Create a movie with three blank scenes.
Insert one cursor in Scene 1, two cursors in Scene 2 and one cursor in Scene 3.
Select the cursor in Scene 1 and notice that it only has one align property, the "Align Forward" icon. This is because it
is located in the first scene of the movie. Since there are no scenes prior to it, there are also no cursors it can be
aligned with but those ones ahead of it. Click the 'Align Forward' icon and you'll notice that the cursor's position is
adjusted so that it matches up with the position of the first cursor in Scene 2.
When you select either the beginning or ending cursor in Scene 2, you'll notice that two align icons become available,
'Align Forward' and 'Align Backward'. This is because other cursors exist both prior to the current scene and after it.
In Scene 3 only the 'Align Backward' icon will appear since no scene, and thus no forward cursor to align to, exists
after it.

See also
Welcome

Introduction

Create new movie

Record the screen

Movie

Scenes

Tools

Character

Timeline

Transformations

Interactivity

Add voiceover narration

Security

Auto

Export

Miscellaneous

Extras

FAQ

Contact

Home > Cursors > Edit cursor path
Edit cursor path
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Creating a custom cursor motion:
After selecting the custom motion icon as the cursor path, you have to define exactly what that custom motion is to be. Position
the playhead at the beginning of the cursor path in the Timeline. Then, click and hold the cursor in the canvas (which will be at
the beginning of the cursor path), and drag it towards the ending of the cursor path, taking whatever route you wish to take (all
the time holding down your left mouse button). Once you've arrived at your destination, release the mouse button. That's it!
You've just set your custom cursor motion.
Editing a custom cursor motion:
If you want to change your custom cursor motion, position the playhead at the point where you want the change to occur (in the
Timeline), then in the canvas, drag the cursor along some new path to the ending point. This will only change that portion of the
custom path that you've redone.
Note: Be careful when selecting a cursor, in the canvas, with a custom motion. If you click on the cursor to select it while the
Playhead is somewhere in the middle of the cursor motion, you will effectively erase the custom motion from the cursor to the
ending point. This action can't be undoneand thus, you will have to recreate the cursor's custom path. Always make sure to
select the cursor in the Timeline, or by clicking on either its starting or ending points in the canvas. Never click in between these
to select the cursor.

See also
Split/Merge cursors

Free Move and Free Resize

Home > Cursors > Split/Merge cursors
Split/Merge cursors
How to Split a cursor motion
You can easily split an existing cursor motion into two separate cursor motions. You may wish to do this if you want one motion
to occur, and the have the motion stop while something else is going on in the scene, then have the cursor motion resume
afterbwards. To split a cursor motion into two motions, first select a cursor motion in the Timeline. Move the playhead inside the
cursor motion, to the position where you want the split to occur. Hold down the CTRL key and drag the right side of the cursor
motion. It is important to drag the "middle" of the new cursor motion and not the small arrow that's at the end of the cursor
motion. Doing so will split the motion, thus creating a new cursor motion.
How to Merge two cursor motions into one
To merge two cursor motions into one cursor motion, you first have to make sure the first cursor motion does not have any click
or doubleclick event associated with it. In the Timeline, move the first cursor motion by clicking the middle of it and dragging it,
until it meets up with the second cursor motion. You'll notice that the two motions will merge into one.
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See also
Edit cursor path

Free Move and Free Resize

Home > Cursors > Free Move and Free Resize
Free Move and Free Resize
Demo Builder allows you to move or resize the cursor motion only if the cursor is always synchronized with the movie. For
example, if a scene has two "changes" and you have a cursor motion in the first "change", you'll notice that you cannot move the
cursor motion to overlap the start of the second "change". To "free move", simply hold down the CTRL key and drag the cursor
motion. To "free resize", hold down the CTRL key and drag the small arrow cursor in the Timeline.

See also
Edit cursor path
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Home > Tools
Tools
The following 'Objects' are available and can be found in both the Tools Panel and Timeline in Demo Builder. Click on an
'Object' below to view full details.

Balloon

Note

Text

Animated Text

Rectangle

Ellipse

Image

Animation

Flash Video

Zoom Area
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Blur

Hotkey
See also
Welcome

Introduction

Create new movie

Record the screen

Movie

Scenes

Cursors

Character

Timeline

Transformations

Interactivity

Add voiceover narration

Security

Auto

Export

Miscellaneous

Extras
Contact

FAQ

Home > Tools > Balloon
Balloon
Balloon properties can be edited in the Design View by clicking on the balloon in the timeline or on the canvas. In the Title tab
you can rename the balloon and in the drop down menu you can edit its size, rotation and location. The Style tab allows you to
edit the style, shape and color of your balloon. In the ClicktoContinue tab you can enable the scene to automatically pause
when the balloon appears. The Text tab allows you to edit the balloon's font; you can also doubleclick inside the balloon to
open the font editor. The TexttoSpeech tab allows you to enable an installed computer voice to read out the text when the
balloon appears. By moving the Angle Wheel you can adjust the direction of the balloon’s tip.
Set the following properties and options for Balloons:

1

Name
The default name for a balloon is 'Balloon X' ('Balloon 1', 'Balloon 2', 'Balloon 3', and so onward), and this is visible in
the name property of the object. You can change a balloon's name by deleting the default name and typing in another one.
Ensure the balloon is selected before attempting to change its name property.

2

Rotate, Scale and Location
Adjust the rotational angles, scale or manually change the location of the balloon on the Canvas. Rotations on the X and
Yaxis are ignored when the balloon is attached to the image.
Learn more...

db11

Tools . 41

Click the Reset button to clear all values.
Click on the individual labels and select Reset to clear the
corresponding value or select Apply to all if you want to apply
your chosen values to all other balloons.

3

Style
The style property allows you to change the appearance (shape, style and color) of the Balloon tooltip. The default style
is 'Classic'. A new balloon style, "Custom" has been added in version 7 which allows you to fully customize a balloon in
terms of color and shape
Learn more...
Border Color
Determines the color for the balloon's edges
Border Width
Changes the thickness of the balloon's edges
Fill Color
Used to specify a color for the balloon
Bevel
Add a 3D beveled edge to the balloon
Drop Shadow
Visual effect consisting of drawing what looks like the shadow of an
object, giving the impression that the object is raised above the objects
behind it
Rounded Corners
Use rounded corners instead of square ones
Shapes
Either a Rectangle or a Ellipse can be employed.

4

Click To Continue
When this option is checked, a 'Continue' button will be placed on the balloon. The movie will be paused, allowing the
viewer to read the content of the balloon and to continue playing only when this button is clicked.
Learn more...
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5

Text
The text property allows you to customize font, font size, font color, text alignment and also edit the text that is visible on
the Balloon tooltip. Click on the 'Text' button in the property panel or doubleclick the body of the balloon to display the
'Text editor'. You can also check the spelling of the entered text.

6

TextToSpeech
For the text to be converted into speech, select the 'TextToSpeech' option. Note : Microsoft TextToSpeech is not
required on the computer used to view your movie.
Learn more...

7

Orientation
Clicking and spinning the 'Angle wheel' allows you to change the orientation of the balloon's tip.

See also
Note

Text

Animated Text

Rectangle

Ellipse

Image

Animation

Flash Video

Zoom Area

Blur

Hotkey

Home > Tools > Note
Note
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Note properties are edited in the Design View by clicking on the note in the timeline or on the canvas. In the Title tab you can
rename the note and in the drop down menu you can edit its size, rotation and location. The Style tab allows you to edit the
style, shape and color of the note and in the ClicktoContinue tab you can enable the scene to automatically pause when the
note appears. The Text tab allows you to edit the note's font; you can also doubleclick inside the note to open the font editor.
The TexttoSpeech tab allows you to enable an installed computer voice to read out the text when the note appears.
Set the following properties and options for Notes:

1

Name
The default name for a note pad is 'Note X' ('Note 1', 'Note 2', 'Note 3', and so onward), and this is visible in the name
property of the object. You can change a note's name by deleting the default name and typing in another one. Ensure the
note is selected before attempting to change its name property.

2

Rotate, Scale and Location
Adjust the rotational angles, scale or manually change the location of the note on the Canvas. Rotations on the X and Y
axis are ignored when the note is attached to the image.
Learn more...
Click the Reset button to clear all values.
Click on the individual labels and select Reset to clear the
corresponding value or select Apply to all if you want to apply
your chosen values to all other notes.

3

Style
The style property allows you to change the appearance (shape, style and color) of the Note Pad. The default style is
'Classic'. A new note style, "Soft" has been added in version 5.0 which provides a very smooth and professional looking
note for your movies. Check the box 'Apply to all notes' at the bottom of the style properties menu to apply the chosen
style to all notes in the movie.
Learn more...
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4

Click To Continue
When this option is checked, a 'Continue' button will be placed on the note. The movie will be paused, allowing the
viewer to read the content of the note and to continue playing only when this button is clicked.
Learn more...

5

Text
The text property allows you to customize font, font size, font color, text alignment and also edit the text that is visible on
the note. Click on the 'Text' button on the property panel or doubleclick the body of the note to display the 'Text editor'.
You can also check the spelling of the entered text.

6

TextToSpeech
For the text to be converted into speech, select the 'TextToSpeech' option. Note : Microsoft TextToSpeech is not
required on the computer used to view your movie.
Learn more...
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See also
Balloon
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Home > Tools > Text
Text
Text properties can be edited in the Design View by clicking on the text in the timeline or on the canvas. In the Title tab you can
rename the text and in the drop down menu you can edit its size, rotation and location. The Style tab allows you to edit the style,
shape and color of the text object. The Text tab allows you to edit the text’s font; you can also doubleclick inside the text
object to open the font editor. In the Text Outline tab you can choose an outline color for the font. The TexttoSpeech tab
allows you to enable an installed computer voice to read out the text when the it appears.
Set the following properties and options for Texts:

1

Name
The default name for a text object is 'Text X' ('Text 1', 'Text 2', 'Text 3', and so onward), and this is visible in the name
property of the object. You can change a text's name by deleting the default name and typing in another one. Ensure the
text is selected before attempting to change its name property.

2

Rotate, Scale and Location
Adjust the rotational angles, scale or manually change the location of the text on the Canvas. Rotations on the X and Y
axis are ignored when the text is attached to the image.
Learn more...
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Click the Reset button to clear all values.
Click on the individual labels and select Reset to clear the
corresponding value or select Apply to all if you want to apply
your chosen values to all other texts.

3

Style
The style property allows you to change the appearance of the Text Area. Check the box 'Apply to all texts' at the
bottom of the style properties menu to apply chosen style to all Text areas in all scenes in the movie.
Learn more...
Click on the pencil symbol to select the color of the border.
Adjust the Thickness and Padding sliders respectively to gain the desired effect
for your text box.
Click on the top bucket symbol to select the color of the background of your text
box.
Press the arrow symbol (pointing downwards) if you desire to add a vertical
gradient to your textbox.
If you have chosen to add a gradient, click the bottom bucket symbol to select
the color of lower portion of the text box. The color of the upper portion of the
textbox will be taken from the top bucket symbol.
Adjust the opacity slider as you see fit for your new textbox.
Check the box Apply to all texts at the bottom of the style properties menu to
apply the chosen style to all Texts in the movie.

4

Text
The text property allows you to customize text formatting options such as font, font size, font color, text alignment and
also edit the text that is visible in the Text area. Doubleclick the body of the Text Properties Menu to edit or insert a Text
area. You can also check the spelling of the entered text.

5

Outline Color
Set the text's outline color. For best results, please use large font sizes.

6

TextToSpeech
For the text to be converted into speech, select the 'TextToSpeech' option. Note : Microsoft TextToSpeech is not
required on the computer used to view your movie.
Learn more...
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See also
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Home > Tools > Animated Text
Animated Text
Animated Text properties can be edited in the Design View by clicking on the animated text in the timeline or on the canvas. In
the Title tab you can rename the animated text and in the drop down menu you can edit its size, rotation and location. The Style
tab allows you to edit the style, shape and color of the animated text. The Text and Effect tab opens the Text Animator window;
here you can customize your animated text’s features (e.g. font, size, animation, etc.).
Set the following properties and options for Animated Texts:

1

Name
The default name for an animated text area is 'Text Animation X' ('Text Animation 1', 'Text Animation 2', 'Text
Animation 3', and so onward), and this is visible in the name property of the object. You can change an animated text's
name by deleting the default name and typing in another one. Ensure the animated text is selected before attempting to
change its name property.

2

Rotate, Scale and Location
Adjust the rotational angles, scale or manually change the location of the animated text on the Canvas. Rotations on the X
and Yaxis are ignored when the animated text is attached to the image.
Learn more...
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Click the Reset button to clear all values.
Click on the individual labels and select Reset to clear the
corresponding value or select Apply to all if you want to apply
your chosen values to all other animated texts.

3

Style
The style property allows you to change the appearance of the Animated Text Area. Check the box 'Apply to all texts' at
the bottom of the style properties menu to apply chosen style to all Animated Texts in all scenes in the movie.
Learn more...
Click on the pencil symbol to select the color of the border.
Adjust the Thickness and Padding sliders respectively to gain the desired effect
for your text box.
Click on the top bucket symbol to select the color of the background of your text
box.
Press the arrow symbol (pointing downwards) if you desire to add a vertical
gradient to your textbox.
If you have chosen to add a gradient, click the bottom bucket symbol to select
the color of lower portion of the text box. The color of the upper portion of the
textbox will be taken from the top bucket symbol.
Adjust the opacity slider as you see fit for your new textbox.
Check the box Apply to all text animations at the bottom of the style
properties menu to apply chosen style to all Animated Texts in the movie.

4

Text and Effect
The text property allows you to customize text formatting options such as font, font size, font color, text alignment and
also to choose a text effect.
Text Animator Wizard...
Text Effect
To apply animation effects to your Text, select the animated text effect desired from the list on the left and view a
preview of the selected effect in the Text Animator Wizard's Preview Window.
Text Editor
Use the Text editor to enter your desired text.
Spell Check
Use this tool to check and correct any spelling errors in your text. When clicked, the Spelling Wizard appears if
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Demo Builder detects any spelling errors in your text. If Demo Builder does not detect any spelling errors, it simple
confirms that spelling check is complete.
Font
To customize your font, font style and size, click on font's name and the Font Wizard appears. Change Font
properties as required and click OK.
Align
Horizontally align your text to the Left, Right or Center. Vertically align your text to the Top, Middle or Bottom.
Animation Speed
Adjust the speed of your animation by sliding the speed indicator from left to right as needed. To slide the speed
indicator, leftclick on the triangle and drag in either direction.

See also
Balloon
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Home > Tools > Rectangle
Rectangle
Rectangles are used to focus the viewer's attention or highlight important information in a scene, you can edit its properties in the
Design View by clicking on it in the timeline or on the canvas. The Title tab allows you to rename the rectangle and in the drop
down menu you can edit its size, rotation and location. The Style tab allows you to edit the style, shape and color of the
rectangle; here you can also choose to dim the outside or inside areas of the rectangle.
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Set the following properties and options for Rectangles:

1

Name
The default name for a shape object is 'Shape X' ('Shape 1', 'Shape 2', 'Shape 3', and so onward), and this is visible in
the name property of the object. You can change a shape's name by deleting the default name and typing in another one.
Ensure the shape is selected before attempting to change its name property.

2

Rotate, Scale and Location
Adjust the rotational angles, scale or manually change the location of the rectangle on the Canvas. Rotations on the X and
Yaxis are ignored when the rectangle is attached to the image.
Learn more...
Click the Reset button to clear all values.
Click on the individual labels and select Reset to clear the
corresponding value or select Apply to all if you want to apply
your chosen values to all other rectangles.
Note : The rectangle cannot be rotated on the Zaxis when the
'Fill outer area' option is selected.

3

Style
The style property allows you to change the appearance of the Shape. For Rectangle shapes: Check the box 'Apply To
all rectangles' at the bottom of the style properties menu to apply chosen style to all Rectangles in all scenes in the movie.
Learn more...
Border Color
Determines the color for the Rectangle's edges
Border Width
changes the thickness of the Rectangle's edges.
Fill Color
Used to specify a color for the Rectangle.
Fill Opacity
Adjust the transparency of the chosen color.
Fill Outer Area
This allows you to fill the 'outside' of the rectangle with the fill color, instead of the
inside of the Rectangle.

See also
Balloon
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Home > Tools > Ellipse
Ellipse
An ellipse is used to focus the viewer's attention or highlight important information in a scene, you can edit its properties in the
Design View by clicking on it in the timeline or on the canvas. The Title tab allows you to rename the ellipse and in the drop
down menu you can edit its size, rotation and location. The Style tab allows you to edit the style, shape and color of the ellipse;
here you can also choose to dim the outside or inside areas of the ellipse.
Set the following properties and options for Ellipses :

1

Name
The default name for a shape object is 'Shape X' ('Shape 1', 'Shape 2', 'Shape 3', and so onward), and this is visible in
the name property of the object. You can change a shape's name by deleting the default name and typing in another one.
Ensure the shape is selected before attempting to change its name property.

2

Rotate, Scale and Location
Adjust the rotational angles, scale or manually change the location of the ellipse on the Canvas. Rotations on the X and
Yaxis are ignored when the ellipse is attached to the image.
Learn more...
Click the Reset button to clear all values.
Click on the individual labels and select Reset to clear the
corresponding value or select Apply to all if you want to apply
your chosen values to all other ellipses.
Note : The ellipse cannot be rotated on the Zaxis when the 'Fill
outer area' option is selected.

3

Style
The style property allows you to change the appearance of the Shape. For Ellipse shapes: Check the box 'Apply to all
ellipses' at the bottom of the style properties menu to apply chosen style to all Ellipses in all scenes in the movie.
Learn more...
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Border Color
Determines the color for the Ellipse's edges
Border Width
Change the thickness of the Ellipse's edges.
Fill Color
Used to specify a color for the Ellipse.
Fill Opacity
Adjust the transparency of the chosen color.
Fill Outer Area
It allows you to fill the 'outside' of the ellipse with the fill color, instead of the inside
of the ellipse.

See also
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Home > Tools > Image
Image
An Image’s properties can be edited in Design View by clicking on the image in the timeline or on the canvas. In the Title tab
you can rename the image and in the drop down menu you can edit its size, rotation and location. You can change the image by
selecting the Replace Image icon and in the drop down menu you can adjust the image’s transparency. Click on the Reset icon
to undo all changes made to the image and adjust the image horizontally or vertically by clicking the Flip and Rotate arrows.
Set the following properties and options for Images:

1

Name
The default name for an image object is 'Image X' ('Image 1', 'Image 2', 'Image 3', and so onward), and this is visible in
the name property of the object. You can change a image's name by deleting the default name and typing in another one.
Ensure the image is selected before attempting to change its name property.

2

Rotate, Scale and Location
Adjust the rotational angles, scale or manually change the location of the image on the Canvas. Rotations on the X and Y
axis are ignored when the image is attached to the image (scene).
Learn more...
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Click the Reset button to clear all values.
Click on the individual labels and select Reset to clear the
corresponding value or select Apply to all if you want to apply
your chosen values to all other images.

3

Replace Image
The replace image icon differs depending on the method used to insert the image.

4

Transparent
This property is enabled for insert options 'From File' and 'Take Screenshot'. It is used to adjust the image's
transparency.
Learn more...
The lefttop pixel is considered a 'transparent' pixel. Checking the transparency box
makes it possible to see through the image. Transparency cannot be applied to an
image from cliparts, the checkbox is disabled when an image is taken from cliparts.

5

Reset
To reset the image to its original size, click the 'Reset' icon.

6

Flip and Rotate
The 'Flip and Rotate' property allows you to flip the image vertically or horizontally and rotate the image by angle.

See also
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Home > Tools > Animation
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Animation
Animations are used to focus the viewer's attention and its properties can be edited in Design View by clicking on it in the
timeline or on the canvas. In the Title tab you can rename the animation and in the drop down menu you can edit its size, rotation
and location. The Style tab allows you to choose from a variety of animations, each with its own properties you can edit. Click
on the Reset icon to undo all changes made to an animation and click on the Animation Builder Shortcut icon to create a new
animation.
Set the following properties and options for Animations:

1

Name
The default name for an animation object is 'Animation X' ('Animation 1', 'Animation 2', 'Animation 3', and so onward),
and this is visible in the name property of the object. You can change an animation's name by deleting the default name
and typing in another one. Ensure the animation is selected before attempting to change its name property.

2

Rotate, Scale and Location
Adjust the rotational angles, scale or manually change the location of the animation on the Canvas. Rotations on the X and
Yaxis are ignored when the animation is attached to the image.
Learn more...
Click the Reset button to clear all values.
Click on the individual labels and select Reset to clear the
corresponding value or select Apply to all if you want to apply
your chosen values to all other animations.

3

Style
The style property allows you to choose an animation such as: rectangle, ellipse, hand and sketch. Each animation has its
own effects and properties.Check the box 'Apply to all animations' at the bottom of the style properties menu to apply the
chosen style to all Animation Objects in all scenes in the movie.
Learn more...

db11

Tools . 55

Category
Choose from rectangle, ellipse, arrow, hand and sketch.
Effect
Choose from additional options that will be shown depending on your
Category's selection.
Color
Choose your preferred color for the Animation from the color palette.
Orientation
Choose the desired direction of motion for the Animation.
Thickness
Set the thickness of the border (including that of sketches).
Drop Shadow
Choose whether to add a drop shadow.
Loop
Select this option to continually replay the Animation.

Note: Depending on the Animation chosen, some options may not be available (e.g. the 'Hand' Animation object).

Create Custom Animations
You have the option to sketch your own animations. In order to sketch, select the 'Sketch' icon from the Animation's
menu and then select 'custom'. Click on the 'Create' button to activate the Animation Builder which will allow you to
sketch freehand any design.
Learn more...
Click the 'double arrow' button in order to export or import your own
animation files.

Custom Animations  Animation Builder
Animation Builder allows you to sketch your own animation simply by draging the mouse over the canvas.
Learn more...
Color
Select the color of the line to be drawn.
Tool
Click the small arrows located to the right of the color button to select a tool from : brush, marker, pen and pencil.
Hide tool at end
Select this option to hide the tool chosen after completion of animation.
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Thickness
change the line's width by dragging the trackbar
Play speed
Adjust the replay speed as needed.
Undo
Revert to the last line drawn.
Erase
Click the eraser to reset the canvas.
Play
Click play to preview your animation.

4

Reset
To reset the animation to its original size, click the 'Reset' icon

5

Animation Builder Shortcut
Use this button to open the Animation Builder.

See also
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Home > Tools > Flash Video
Flash Video
Flash video allows you to play an MP4 (H264) or FLV format video within a scene and its properties can be edited in the Design View by
clicking on the flash video in the timeline or on the canvas. The Title tab allows you to rename the flash video and in the drop down menu you
can edit its size, rotation and location. In the Source tab you can choose between ‘Progressive Download Video’ and ‘Streaming Video’ options
for your video source. The Skin tab allows you to choose between various player bar styles. The Reset to Original Size icon will undo any size
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changes made to the flash video and the Maintain Aspect Ratio icon will preserve its original aspect ratio. The Autoplay icon plays the flash
video automatically when it appears on screen and the Autorewind icon automatically rewinds the video at the end.

Set the following properties and options for Flash Videos:

1

Name
The default name for a flash video object is 'Flash Video X' ('Flash Video 1', 'Flash Video 2', 'Flash Video 3', and so
onward), and this is visible in the name property of the object. You can change a flash video's name by deleting the
default name and typing in another one. Ensure the flash video is selected before attempting to change its name property.

2

Rotate, Scale and Location
Adjust the rotational angles, scale or manually change the location of the flash video on the Canvas. Rotations on the X
and Yaxis are ignored when the flash video is attached to the image.
Learn more...
Click the Reset button to clear all values.
Click on the individual labels and select Reset to clear the
corresponding value or select Apply to all if you want to apply
your chosen values to all other flash videos.

3

Source
As with most other internet video and audio formats, Flash provides two different ways to deliver AV media from a web
page: 'Progressive Download Video' and 'Streaming Video'.
Learn more...
Progressive Download Video
Progressive downloading is the easiest way to display Flash Video on a
web page. Although it is not as powerful and flexible as true streaming, it
simulates streaming fairly well and most endusers will not know the
difference. Please note that the enduser cannot jump ahead to a later part
of the video until it has fully downloaded.
Path: Browse to the relative or absolute path of the FLV or MP4 file. For
example: c:\path\to\video.flv OR http://domain.com/video.flv
Streaming Video
To stream Flash video you need to use a special type of server application
called Flash Media Server (FMS). The Adobe Flash Media Server (FMS,
formerly Flash Communication Server) is the powerhouse solution for Flash
streaming. The FMS is basically a software package which runs on a
normal web server and provides extra functionality for the Flash format (e.g.
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live streaming, chat, etc).
In technical terms, the FMS works by opening a 'persistent connection'
between the server and client (enduser). In a normal server/client
relationship the client sends periodic requests to the server as required.
With a persistent connection the server and client are in constant, controlled
contact.
URI: Enter the server name, application name, and instance name . For
example, rtmp://server/app/instance. Stream: Enter the stream name.
In the 'Width'/'Height' box, specify the width/height of the Flash Video. Click 'Detect Size' if you want to detect the
original size of the FLV or MP4 file.
Starting with version 9.3, YouTube videos can be played within your Demo Builder movie. To do so, select 'Progressive
Download' then enter the URL to your desired YouTube video.
e.g. In the Path field, enter : http://www.youtube.com/watch?v=ynR8nz4Xl_s
4

Skin
Select the skin you want to use in your video. 'Skin' refers to the way the video playbar appears within your movie.

5

Reset to original size
To reset to the size of the original Flash Video, click this button.

6

Maintain aspect ratio
To preserve the aspect ratio of the original Flash Video, click this button.

7

AutoPlay
Start playing the video file automatically.

8

AutoRewind
Automatically rewind the video at the end.

See also
Balloon

Note

Text

Animated Text

Rectangle
Image

Ellipse
Animation

Zoom Area
Hotkey

Blur

Home > Tools > Zoom Area
Zoom Area
Zoom areas can be used to focus a viewer's attention by zooming in on important parts of a scene. Its properties are edited in
the Design View by clicking on the zoom area in the timeline or on the canvas. In the Title tab you can rename the zoom area
and in the drop down menu you can edit its size, rotation and location. In the Source tab you can edit which part of the scene
you want to zoom in to and the Style tab allows you to customize the zoom area (e.g. change border width, add glow effect,
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etc.). Selecting the Live icon will allow the zoom area to play what is happening in the background in real time instead of
displaying a static image.
Set the following properties and options for Zoom Areas:

1

Name
The default name for a zoom area object is 'Zoom Area X' ('Zoom Area 1', 'Zoom Area 2', 'Zoom Area 3', and so
onward), and this is visible in the name property of the object. You can change a zoom area's name by deleting the
default name and typing in another one. Ensure the zoom area is selected before attempting to change its name property.

2

Rotate, Scale and Location
Adjust the rotational angles, scale or manually change the location of the zoom area on the Canvas. Rotations on the X
and Yaxis are ignored when the zoom area is attached to the image.
Learn more...
Click the Reset button to clear all values.
Click on the individual labels and select Reset to clear the
corresponding value or select Apply to all if you want to apply your
chosen values to all other zoom areas.

3

Source
Select the area of the scene that you want to magnify.
Learn more...
Select or resize the source rectangle using the mouse or
keyboard.
CTRL + Arrows  to move selection
SHIFT+ Arrows  to resize selection
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4

Style
Set the properties for a zoom destination area. You can draw a border around the zoom area, dim the background, apply
a glow effect or cover the source rectangle.
Learn more...
Border  Color and Width
Dim Background  Color and Opacity
Glow Effect  Color
Cover  Encircles your source area in the color of your choosing.

5

Live
The 'zoom destination' may be used to display a static image, or exactly what’s happening on the Canvas, in realtime
(live), including the cursor.

See also
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Home > Tools > Blur
Blur
A Blur area is used to block information in a scene (e.g. an email address captured during recording) and its properties can be
edited in the Design View by clicking on the blur area in the timeline or on the canvas. The Title tab allows you to rename the
blur area and in the drop down menu you can edit its location. The Radius tab allows you to adjust the intensity of the blur area.
Set the following properties and options for Blur areas:

1

Name
The default name for a blur area is 'Blur X' ('Blur 1', 'Blur 2', 'Blur 3', and so onward), and this is visible in the name
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property of the object. You can change an blur area's name by deleting the default name and typing in another one.
Ensure the blur area is selected before attempting to change its name property.
2

Location
Change the location of the blur area on the Canvas.
Learn more...
This object cannot be rotated on the X,Y,Zaxis. Also, it cannot be scaled.

3

Radius
The radius property allows you to adjust the intensity of the blur effect. Check the box 'Apply to all blur areas' at the
bottom of the radius menu to apply the chosen radius to all Blur areas in all scenes in the movie.
Learn more...

See also
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Home > Tools > Hotkey
Hotkey
A Hotkey can be used to show the viewer a keyboard combination used in a program that was recorded and its properties can
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be edited in the Design View by clicking on the hotkey in the timeline or on the canvas. The Title tab allows you to rename the
hotkey and in the drop down menu you can edit its location. In the Style tab you can edit the style and size of the hotkey and the
Shortcut tab allows you to edit its keyboard combinations.
Set the following properties and options for Hotkeys:

1

Name
The default name for a hotkey is 'Hotkey X' ('Hotkey 1', 'Hotkey 2', 'Hotkey 3', and so onward), and this is visible in the
name property of the object. You can change an hotkey's name by deleting the default name and typing in another one.
Ensure the hotkey is selected before attempting to change its name property.

2

Location
Change the location of the hotkey on the Canvas.
Learn more...
Click the Reset button to clear all values.
Click on the individual labels and select Reset to clear the
corresponding value or select Apply to all if you want to apply
your chosen values to all other hotkeys.

3

Style
The style property allows you to change the appearance of the Hotkey. The default style is 'Classic'.
Learn more...

4

Shortcut
The shortcut property allows you to change the keyboard combinations.
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Home > Character
Character
The Character feature allows you to add an animated character to help narrate your movie. You can find this option in the top
panel when you open a scene in the Design view. Click on the Character tab to select either Amy or Joey and adjust their size,
screen orientation and stance. Once you have added a character to a scene, panels for editing their movements and speech will
appear to the right of the Canvas and in the Timeline.
Please note that due to Flash limitations characters are not exported in Flash format.
See also
Welcome

Introduction

Create new movie
Movie

Record the screen
Scenes

Cursors
Timeline

Tools
Transformations

Interactivity
Security

Add voiceover narration
Auto

Export
Extras

Miscellaneous
FAQ

Contact

Home > Character > Add
Add
Characters can be used to create a more eyecatching movie and are useful for explanations in tutorials. They can be added to
your movie in the Design View.

To add a Character open a scene in the Design View, then click on the character drop down menu in the top panel and choose
from either Amy or Joey to be added to the scene. The Character stance, position and size can also be edited in this menu.
Once the character appears in the scene, further options for movement and animation will become available in a character menu
to the right of the Canvas.

See also
Properties
Working with Timeline
objects
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Home > Character > Properties
Properties
In Design view you can select either Amy or Joey, and then choose where they initially appear in the scene and if they should
face to the left, right or forward. You can also adjust the character’s height. Selecting AutoHide will hide the character from
view whenever they are not performing an action and you can allow them to appear in all scenes by selecting Apply to all
Scenes.

1

Style
Select a character from the drop down menu, here you can choose between Amy and Joey. The default setting is None,
so no character will appear on the Canvas initially.

2

Initial State
Select one of these figures to allow the character to face left, center or right. The red numbers show the character's
position on the Canvas, clicking on these numbers opens a menu with options to return the character to its original
position, align it to the left, center or right of the screen and align it to a previous character position.

3

Height
The Height Bar allows you to adjust the size of your character.

4

Auto Hide
Select Auto Hide to make the character disappear from the Canvas when it is not performing an action or movement.

5

Warning
Changing the initial properties of a character may result in changes in character animations you have already made. For
example, if you have created a walk animation and then increase the character's height, the end position will change as
larger characters will take larger steps and may result in the character walking off screen.

6

Move
Clicking and dragging the cursor within the move block allows you to position the character anywhere on the canvas.

See also
Add

Direct Your Character
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Working with Timeline
objects

Home > Character > Direct Your Character
Direct Your Character
Once you have positioned your character, choose from a wide variety of actions in the Direct Your Character panel which will
appear to the right of the Canvas. Each of the action tabs in this panel allows you to conveniently preview the action in the scene
by clicking the Play icon and when satisfied you can click the Add icon to add the action to the Timeline where it can be moved
around to adjust its start and end times. Selecting the Smooth in Design Mode icon (bottom left of the panel) will render the
character in a better image quality during the editing phase, but this may also slow down the program; the character will however
always be exported as "smooth".
A Character State is the initial direction a character faces, this can be set to facing slightly left, slightly right or center (facing the
audience). A character will always appear in the scene in one of these 3 states.
When a character appears in the scene it will do so by "fading in" and when the scene ends the character will fade out.
Alternatively you can place the character off screen initially and add a walk animation to have them walk on screen.

Selecting the Smooth in Design Mode option only changes Character image quality in the Editing phase, as a Character will
always be exported in a higher image quality whether this option is selected or not. Leaving the Character in a lower image
quality during editing will allow the program to run smoother, especially for older computers.

Speak

Eyes
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See also
Add

Properties

Working with Timeline
objects

Home > Character > Direct Your Character > Speak
Speak
Give the character speech by using an installed voice on your Computer, imported audio or a recorded voice. You can type out
text or choose from Preset texts. You can also edit the tone of the voice in the Speech Synthesis Markup Language menu. Click
the Live Spell icon to keep track of spelling mistakes.

TextToSpeech

Record
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Import
See also
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Home > Character > Direct Your Character > Speak > TextToSpeech
TextToSpeech
Type out text to convert to speech or choose from preset texts and select an installed voice on your computer for your character
to use.

1

Add
Once you have typed out your text and selected a voice installed on your computer, click the add button to add the
sound file to the Timeline, where it can be moved to adjust its start and end times.

2

Play
Click the Play button to listen to the text you have typed.
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3

Delete
Click Delete to clear the text.

4

Preset Text
Click this icon to open the Preset Text Menu, here you can choose from 5 default texts or select Edit to change the
default texts or add your own preset texts.

5

SSML
Speech Synthesis Markup Language is a speech synthesizer that allows you to edit the tone, pronunciation, volume, pace
and pitch of texttospeech. In the drop down menu you can select sentence and paragraph reading as well as adjust
more specific parts of speech, such as spelling, emphasis, pitch and rate. If you want to find out more about the
synthesizer select Learn About SSML.

6

Spelling
LiveSpell is a built in spelling checker, toggle it to keep track of any spelling errors.

7

Voice
Click this option to select a voice installed on your computer.

8

Editor
Type out your text in this panel.

Once your TexttoSpeech sound files are added to the Timeline, if you wish to edit them simply rightclick on the sound wave
in the Timeline and select Load Text from the pop up menu, the text will then appear in the Direct Your Character panel to the
right of the Canvas where it can be edited.

See also
Record

Import

Home > Character > Direct Your Character > Speak > Record
Record
Use your computer microphone to record audio and add it as character speech. To record audio for the character, select
Record at the bottom of the Speech Panel to switch to an audio recording screen.
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1

Add
Once you are satisfied with your recorded audio, click Add to save it to the Timeline.

2

Play
Click Play to listen to your recorded audio.

3

Record
Click the Microphone icon to start recording and again to stop recording when you are done. After clicking Stop a sound
wave of the recording will appear in the speech panel.

4

Narrate Timeline
Selecting this option will allow you to play the movie while you record audio, when this option is not selected the movie
will automatically pause when you start recording.

5

Audio Options
In the Recording options menu you can select a recording device, adjust the volume and calibrate your microphone.

6

Delete
Select Delete to clear the recorded audio.

7

Edit
Once you have a recording, select the Edit icon to open the built in Audio Editor, where you can adjust the volume, crop
the audio and insert silences.

See also
TextToSpeech
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Home > Character > Direct Your Character > Speak > Import
Import
Import audio files saved on your computer to use as your character's speech. To import audio in the Speak tab select Import at
the bottom of the Direct Your Character panel then click on the File icon, select an audio file to import and it will appear as a
sound wave in the panel. You can also further edit the audio file by opening the Audio Editor (the Pencil icon).

1

Add
Once you have chosen an audio file from your computer and edited it to your liking, click Add to save it to the Timeline.

2

Play
Click Play to preview your audio file.

3

Open
This option opens a computer browser, here you can select a saved audio file and open it in Demo Builder.

4

Delete
Use Delete to clear an audio file you have opened.

5

Edit
Once you have opened an audio file, select the Edit icon to open the built in Audio Editor, where you can adjust the volume,
crop the audio and insert silences.
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See also
TextToSpeech

Record

Home > Character > Direct Your Character > Eyes
Eyes
Move the cursor in the center according to the direction you want the eyes to move. Once you have a recorded eye movement,
you can select the Release icon to allow the eyes to return to the center after the movement. You can also adjust the speed of
this movement (for this to apply it should be adjusted before recording the movement).

1

Add
Once you have created an eye movement in the Drag Area, select Add to save it to the Timeline where it can be adjusted
to change its start and end times. If the Red Playhead is at the end of the Timeline, the animation will automatically extend the
Timeline.

2

Play
Select Play to see a preview of the eye movement you created in the Drag Area. If the Red Playhead is at the end of the
Timeline you will not be able to preview the animation, to make preview possible extend the Timeline or place the Red
Playhead at an earlier point in the Timeline.

3

Delete
Select Delete to delete an eye movement you have made.
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4

Release
Once you have added an eye movement to the Timeline, the Release option will become available. If you select Release,
after the movement the character's eyes will return to its starting central position. If you do not click release, the
character's eyes will remain in the last position of the movement.

5

Drag Area
The Drag Area allows you to create eye movements. Click and drag the cursor around the Area in the direction you want
the eyes to move, releasing the mouse button will end the eye movement.

6

Speed
Adjust the speed of the movement, this only applies if the speed is adjusted before you record the eye movement.

See also
Speak
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Home > Character > Direct Your Character > Head
Head
As with the eyes, move the cursor according to the direction you want the head to move. Once you have a recorded movement,
you can select the Release icon and the head will return to its original position after the movement. You can also adjust the speed
and flexibility of this movement (for these to apply they should be adjusted before recording the movement).
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1

Add
Once you have created a head movement in the Drag Area, select Add to save it to the Timeline where it can be adjusted to
change its start and end times. If the Red Playhead is at the end of the Timeline, the animation will automatically extend the
Timeline.

2

Play
Select Play to see a preview of the head movement you created in the Drag Area. If the Red Playhead is at the end of the
Timeline you will not be able to preview the animation, to make preview possible extend the Timeline or place the Red
Playhead at an earlier point in the Timeline.

3

Delete
Select Delete to delete a head movement you have made.

4

Release
Once you have added a head movement to the Timeline, the Release option will become available. If you select Release, after
the movement the character's head will return to its starting central position. If you do not click release, the character's head
will remain in the last position of the movement.

5

Drag Area
The Drag Area allows you to create head movements. Click and drag the cursor around the Area in the direction you want the
head to move, releasing the mouse button will end the head movement.

6

Flexibility
Select this option to adjust the character's neck flexibility, the higher the flexibility the further the head will turn. Select
Reset to undo any flexibility changes. For this adjustment to apply, it should be made before recording a head movement.

7

Speed
Adjust the speed of the movement, this only applies if the speed is adjusted before you record the head movement.
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See also
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Home > Character > Direct Your Character > Point
Point
This option allows the character to point with either its left or right arm, use the cursor to edit this movement and click on the Idle
icon to allow the character to return to its original position after the movement. You can also adjust the speed (for this to apply it
should be adjusted before recording the movement).

1

Add
Once you have created a point movement in the Drag Area, select Add to save it to the Timeline where it can be adjusted to
change its start and end times. If the Red Playhead is at the end of the Timeline, the animation will automatically extend the
Timeline.

2

Play
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Select Play to see a preview of the point movement you created in the Drag Area. If the Red Playhead is at the end of the
Timeline you will not be able to preview the animation, to make preview possible extend the Timeline or place the Red
Playhead at an earlier point in the Timeline.
3

Delete
Select Delete to delete a point movement you have made.

4

Idle
Once you have created a point movement and added it to the Timeline, you can select Idle, this will add an animation
after the point movement to allow the character to return to its normal stance.

5

Drag Area
The Drag Area allows you to create point movements. Click and drag the cursor around the Area in the direction you want the
character's left or right arm to move, releasing the mouse button will end the point movement.

6

Speed
Adjust the speed of the movement, this only applies if the speed is adjusted before you record the point movement.

See also
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Home > Character > Direct Your Character > Pose
Pose
In this tab you can choose from a variety of poses and gestures for a character to use while talking. A character will remain in a
selected pose unless a new pose is added to the Timeline or the Idle icon is selected, this adds an animation to the Timeline that
returns the character to its normal state.

db11

Character . 77

1

Add
Once you have chosen a movement from the available Pose animations, select Add to save it to the Timeline where it can be
adjusted to change its start and end times. If the Red Playhead is at the end of the Timeline, the animation will automatically
extend the Timeline.

2

Play
Click Play to see a preview of the animation you have selected. If the Red Playhead is at the end of the Timeline you will not
be able to preview the animation, to make preview possible extend the Timeline or place the Red Playhead at an earlier point
in the Timeline.

3

Delete
Click Delete to clear the animation you have selected or simply click on a different animation if you want the character to
use a different action.

4

Idle
Once you have chosen a Pose animation and added it to the Timeline, you can select Idle, this will add an animation after the
movement to allow the character to return to its normal stance. If Idle is not selected, the character will remain in the Pose
selected.

5

Animations
Select a pose animation to accompany your character's speech. When you select an animation it will be highlighted in
blue, click Play to preview it and Add to save it to the Timeline.

See also
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Home > Character > Direct Your Character > Mimic
Mimic
These actions mimic computer actions (e.g. click, type, select, etc.), you can use these to prompt viewers to click on a link or
type in an answer.

1

Add
Once you have chosen a Mimic animation, click Add to save it to the Timeline, where it can be adjusted to change its start
and end times. If the Red Playhead is at the end of the Timeline, the animation will automatically extend the Timeline.

2

Play
Once you have selected a Mimic animation, you can select Play to preview it. If the Red Playhead is at the end of the
Timeline you will not be able to preview the animation, to make preview possible extend the Timeline or place the Red
Playhead at an earlier point in the Timeline.

3

Delete
Click Delete to clear the animation you have selected or simply click on a different animation if you want the character to use a
different action.
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4

Animations
Select a Mimic animation to prompt the viewer to complete a computer action (e.g. click, drag and drop, etc.). When you select
an animation it will be highlighted in blue, click Play to preview it and Add to save it to the Timeline.

See also
Speak
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Home > Character > Direct Your Character > Actions
Actions
Choose from a variety of actions to illustrate your movie (e.g. waving, clapping, bowing, etc.), these can be used in the movie
intro and end. For introductions you can use the Bow or Wave animations as greetings, Strong animations can be used for
emphasis and Subtle animations can be used as 'filler' animations, to allow your character some movement when they are not
performing actions, but still appear on screen. Farewell actions can be used to end your movie.

1

Add
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Once you have chosen an Action, click Add to save it to the Timeline, where it can be adjusted to change its start and end
times. If the Red Playhead is at the end of the Timeline, the animation will automatically extend the Timeline.
2

Play
Once you have selected an Action, you can select Play to preview it. If the Red Playhead is at the end of the Timeline you will
not be able to preview the Action, to make preview possible extend the Timeline or place the Red Playhead at an earlier point
in the Timeline.

3

Delete
Click Delete to clear the Action you have selected or simply click on a different Action if you want the character to perform a
different movement.

4

Animations
When you select an Action it will be highlighted in blue, click Play to preview it and Add to save it to the Timeline.

See also
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Eyes

Head

Point

Pose

Mimic

Walk

Home > Character > Direct Your Character > Walk
Walk
Use this tab to allow your character to walk across the screen or rotate (the direction it is facing). The Steps bar adjusts the
direction and distance of the walk, Style determines how the character will walk (forward, back or side stepping) and End
determines the characters end position.
Rotate
When a character appears in a scene it will be in 1 of 3 states (facing left, right or the audience). Rotating the character will allow
it to turn from its initial state to look at something else and this can be done without making the character walk by leaving the
steps option at 0 (in the center of the steps bar). Selecting a new state will add an animation in the Timeline to turn the character
and it will remain in this state until another state is added.
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1

Add
Once you have chosen a Rotate animation, click Add to save it to the Timeline, where it can be adjusted to change its start and
end times. If the Red Playhead is at the end of the Timeline, the animation will automatically extend the Timeline.

2

Play
Once you have selected a Rotate animation, you can select Play to preview it. If the Red Playhead is at the end of the Timeline
you will not be able to preview the Action, to make preview possible extend the Timeline or place the Red Playhead at an
earlier point in the Timeline.

3

Delete
Click Delete to clear the Rotation animation you have selected or simply click on a different Rotation animation if you want the
character to turn in a different direction.

4

End State
The End States (character facing left, center or right) are usually used for a character after they have walked across the
screen, but can also be used to simply change the direction the character faces (e.g. to focus a viewer's attention to a
different part of the screen) without making the character walk.

Walk
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1

Add
Once you have created a walk sequence, click Add to save it to the Timeline, where it can be adjusted to change its start and
end times. If the Red Playhead is at the end of the Timeline, the Walk animation will automatically extend the Timeline.

2

Play
When you have chosen a direction, stepping distance and walking style, you can select Play to preview it. If the Red Playhead is
at the end of the Timeline you will not be able to preview the Action, to make preview possible extend the Timeline or place
the Red Playhead at an earlier point in the Timeline.

3

Delete
Click Delete to clear a walk sequence you have created.

4

Steps
Move the cursor left or right along the bar to allow the character to walk in either direction, here you can create a walk
sequence up to 10 steps in a single direction. The distance of each step is dependent on the character's size, this is
important to note when changing the character's initial size (e.g. the same walk for a larger character may take it off
screen). A faded image of the character will appear on the canvas to indicate where the walk end position will be.

5

Style
Choose between walking forward, walking backward or side stepping. Forward stepping covers the most distance,
whereas backward and side stepping covers a shorter distance.

6

End State
The End States (character facing left, center or right) can be used to allow the character to face a different direction after they
have walked across the screen.

When a Walk animation has been saved to the Timeline you can rightclick on it and select Load Values, doing this will bring up
the settings you selected for the walk animation in the Direct Your Character Panel.
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See also
Speak

Eyes

Head

Point

Pose

Mimic

Actions

Home > Character > Working with Timeline objects
Working with Timeline objects
To save any animations to the Timeline, simply select the Add icon in the Direct Your Character Panel. Once you have created
or selected an animation you will see a Red Bar outline after the Red Playhead in the Timeline, this shows you the duration of the
animation before you save it to the Timeline.

1

Add
The Red Bar indicates an animation's duration, it appears when you create or select an animation in the Direct Your
Character Panel (e.g. after you create a head movement, the Red Bar appears in the Timeline before you save the
animation to the Timeline).

2

Freeze Zone
A Freeze Zone is the light blue bar between animations. This occurs when you create an animation where the character
does not revert back to its original stance, during the Freeze Zone a character will remain in the end position of the last
animation it performed (e.g. head turned to the left) until a new animation occurs, or the Release icon (eyes, head) or the
Idle icon (point, pose) is selected. If no new animation is created, the Freeze Zone will continue until the end of the
Timeline.

3

TextToSpeech / Load
Selecting this option will bring up the text for the TextToSpeech audio in the Direct Your Character Panel.

4

Walk / Load
Selecting this option will bring up the settings you selected for the walk animation in the Direct Your Character Panel.
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See also
Add
Direct Your Character
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Home > Timeline
Timeline
An object's position in the Timeline determines when that object becomes visible in the scene at runtime. 'Timeline Properties'
allow you to specify when the object appears, how it appears and how long it is displayed for.
Depending on the object being worked on, the Timeline's appearance will adapt to show the options available for that specific
object. Please note that objects with 'Events'(buttons , click zones and edit zones) are unique in that each individual event will
have its own Timeline to enable you to precisely control the appearance and behavior of the event and the particular objects
and actions making up that event.

Playhead
The Playhead is a red vertical line with a red rectangle at the top, and is displayed in the Timeline. The Playhead indicates the
location of the movie within the Timeline. You can drag the Playhead with your mouse to the left or the right, and as you do, you
will be advancing the play of the movie in the Canvas area. Alternatively, you can click the green arrow above the Timeline to
automatically 'play' the movie, watching the Playhead advance automatically. There are also 'beginning' and 'end' icons on either
side of the play button, that when clicked, automatically advances the Playhead to the beginning or to the end of the scene. The
playhead is an extremely effective tool for going to a precise location within a movie.
Changes
Only for fullmotion recordings. You can choose to show consecutive strips with alternate colors to better view 'changes' in the
Timeline.
Tracks
You can have an unlimited number of 'tracks' in your Timeline. A track is a horizontal location that runs from time zero to some
time in the future and it is in these tracks that objects will exist. For example, if you want an image to display for 3 seconds,
starting 1 second into a theme, then that image will be displayed in a track on the Timeline, and it's length will be from the 1
second point to the 4 second point. The object will therefore be displayed for 3 seconds(see Preferences , Defaults Tab). If you
then want another object to display after the first object disappears, you can place this object in the same track, after the first
object. However, you can also display the new object in a second track, below the first track. You would do this if, for
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example, you wanted the second object to display before the first object had vanished. In other words, objects can 'overlap'
when placed in separate tracks.
The track that an object is in has no bearing on the resulting movie. Therefore, it is often good practice to limit the number of
tracks in use or otherwise you may end up with a Timeline that is difficult to navigate.... having to often scroll up and down more
than would otherwise be necessary. An easy way to limit the number of required tracks is to use the Float feature.
Float
Use the Float feature to condense your objects into the least number of required tracks in the Timeline. Doing so will
automatically condense the objects into the least number of tracks required.
Changes and Cursor Lock
If the Lock is turned on, then you cannot adjust/move any change/cursor motion in the Timeline or in the Canvas.
Add Mark
Above the Timeline and near the left side (but to the right of the green play button) there is another PLUS ('+') icon. This is the
'Add Mark' icon, and when clicked, will add a Mark to the Timeline in the location where the Playhead is located. A 'Mark' will
be displayed as a small number at the top of the Timeline. You can add as many Marks to a scene as you like. Marks are useful
to identify locations within a scene/movie and can also be tied to specific actions.
Magnet (Snapto Timeline)
If you have more than one object in a given scene, and if it's important to you that this object begins to play right after the
previous object ends, activate the 'Magnetic Ride' feature. Simply select 'Magnetic Ride' from the 'Options' drop down menu (or
by rightclicking in the Timeline). Then, when you click on an object in the Timeline and drag it to the position you want, you'll
notice that it "snaps" into position as you drag it near another object. This is a handy feature that helps position objects in the
exactly where you want them in the Timeline.
Split
The 'Split' feature allows you to split a scene into two separate scenes. To split a scene, simply position the Playhead in the
location where you wish to split the scene. The result will be two separate scenes that must be edited separately.
Merge
Although not an option in the Timeline options, merging two or more scenes into one scene is essentially the opposite of
'Splitting' scenes. To merge multiple scenes into one scene, you need to go to Thumbnail View.You can do this by clicking on
your movie's title in the left margin in Design View or by pressing the homeshaped icon. Here, select the scenes you wish to
merge by holding down CTRL and clicking the individual scenes (or by dragselecting all scenes to be merged). Then, rightclick
on any of the selected scenes, and select 'Merge' from the resulting menu. All of the selected scenes will be merged into one,
longer scene.
Select Multiple Objects
If you want to select multiple objects in the Timeline, perhaps because you want to move them all at the same time and by the
same amount of time, you can do so simply by holding the CTRL and clicking on each object.

Insert extra time

Delete/Erase Selection
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Transition per object

Transition per scene

Marks

Equalize Scenes

Hide/Attach/Lock Object

Adjust Playback speed
See also
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Home > Timeline > Insert extra time
Insert extra time
In order to insert space in the Timeline, drag the Playhead extension rightwards (found on the top right side of the Playhead), as
shown below.
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See also
Delete/Erase Selection

Transition per object

Transition per scene

Marks

Equalize Scenes

Hide/Attach/Lock Object

Adjust Playback speed

Home > Timeline > Delete/Erase Selection
Delete/Erase Selection
The 'delete' function serves to delete an entire section, as chosen by you, of the Timeline. This includes everything in that section,
such as all of the objects present. This is different from 'erasing' in that unlike 'deleting', 'erasing' will not resize or delete any
objects or cursors.
Deleting a selection in the Timeline will delete that entire section, and everything in it. For example, it will delete any objects that
existed in that section. To delete a selection within the Timeline, follow these instructions. Position the Playhead at the beginning
of the area you wish to delete, hold down the CTRL key and drag the Playhead from this position to the end of the selection you
wish to delete. As you do this, two new icons will appear above the Timeline, one of which is the DELETE icon (a red X).
Simply click the DELETE icon and the entire selected area in the Timeline will be deleted.

Note: Take care when deleting a section of your Timeline, as this action cannot be undone.
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Erasing a selection in the Timeline will only delete the changes in the selected area, and not affect the timing. Unlike deleting
(above), erasing will not resize and/or delete any objects or cursors. To erase a selection within the Timeline, follow these
instructions. Position the Playhead at the beginning of the area you wish to erase, hold down the CTRL key and drag the
Playhead from this position to the end of the selection you wish to delete. When you do this, two new icons will appear above
the Timeline, one of which is the ERASE icon (looks like a white eraser). Simply click the ERASE icon and the entire selected
area in the Timeline will be erased.

Note: Take care when erasing a section of your Timeline, as this action cannot be undone.

See also
Insert extra time

Transition per object

Transition per scene

Marks

Equalize Scenes
Adjust Playback speed

Hide/Attach/Lock Object

Home > Timeline > Transition per object
Transition per object
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1

Transition In
Used to determine how Objects appear within the movie. This property is not available for Cursor motion objects,
Animated Texts, Rectangles, Ellipses, Edit Zones, Buttons, Click Zones and Animations. When you click on the
'Transition In' panel, the Transition In wizard appears (as seen above). Select from the list of effects on the left and view
the chosen effect in the preview window of the wizard. When you select an effect other than 'none', you can specify the
duration of the effect as the object phases into the scene.

2

Time
Displays how long an object or scene is visible during runtime.
To adjust 'Time for Objects', click on the edge of the relevant object within the Timeline and drag to extend or decrease.
To adjust 'Time for Scenes', click on the line marking the end on the scene and drag to increase or decrease.

3

Transition Out
Used to determine how an object exits the scene at runtime. This property is not available for Cursor's motions, Animated
Texts, Rectangles, Ellipses, Edit Zones, Buttons, Click Zones and Animations. When you click on the 'Transition Out'
panel, the Transition Out wizard appears. Select from the list of effects on the right and view the chosen effect in the
preview window of the wizard. When you select an effect other than 'none', you can specify the duration of the effect as
the object phases out of the scene.

See also
Insert extra time

Delete/Erase Selection

Transition per scene

Marks

Equalize Scenes

Hide/Attach/Lock Object

Adjust Playback speed

Home > Timeline > Transition per scene
Transition per scene
Transitions are used to determine how a Scene will appear in the movie at runtime. When you click on the 'Transitions panel', the
Transition wizard appears. Select from the list of effects on the left and view the chosen effect in the preview window of the
wizard. When you select an effect other than 'none', you can also specify the duration of the transition.
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See also
Insert extra time

Delete/Erase Selection

Transition per object
Equalize Scenes

Marks
Hide/Attach/Lock Object

Adjust Playback speed

Home > Timeline > Marks
Marks

Marks are essentially bookmarks within a scene. These can be used to specify actions and where you want an action to occur.
Marks can either be added to a scene automatically during the recording process, or manually during the editing phase after
recording. For example: You can use marks to make the movie jump from Scene 1/Mark 1 to Scene 3/Mark 4 if Scene 1/Mark
1 has Action "Go To Scene" with Scene3/Mark4 as the parameters.
To manually add a Mark to a scene, place the Playhead at the location where you want the mark added, then click the "+"
button above the Timeline next to the Play button. To remove a Mark from a scene, position the Playhead over the mark to be
deleted or select the Mark's number from below the Timeline. You'll notice that the "+" button changes to "" . Press this button
in order to remove the Mark. To move a Mark, move the mouse over it, or select it by clicking on its number, and drag it to a
new location.
To change the Action for a Mark, select it (move the Playhead to its position or click on it in the Timeline), and then click the
dropdown menu immediately to the right of the "+" or "" icons above the Timeline. You'll notice that there are several actions
to choose from : Stop Movie , Loop Movie, Close Movie, Go To URL, Run EXE,Go To Movie, Execute JavaScript
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See also
Insert extra time

Delete/Erase Selection

Transition per object
Equalize Scenes

Transition per scene
Hide/Attach/Lock Object

Adjust Playback speed

Home > Timeline > Equalize Scenes
Equalize Scenes
Located in the Options menu, use "equalize scenes" to apply the current scene's length to all of the scenes that make up the
movie.

See also
Insert extra time

Delete/Erase Selection

Transition per object
Marks

Transition per scene
Hide/Attach/Lock Object

Adjust Playback speed

Home > Timeline > Hide/Attach/Lock Object
Hide/Attach/Lock Object
Go to Transformations/Objects/Marks window and select the Objects tab to adjust any of the following options:
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Lock(Canvas and Timeline)
In the Objects tab, you can "lock" the objects in a scene so that they cannot be edited or moved accidentally.Click on the
"Objects" icon at the top and all of the objects in your scene will be displayed. Select the object to be locked by clicking
on it in the list"lock" it by clicking on the lockshaped icon next to its description. With this lock in place, you can no
longer move, adjust or edit this the object on the canvas or in the Timeline. This is a safety measure to prevent you from
accidentally moving something you didn't intend to.
Visibility(Design time)
You can also set an object's visibility in a scene to either 'ON' or 'OFF'  for example, you can have an object not
display, without actually deleting it. Click on the "Objects" icon at the top and all objects in your scene will be displayed.
Select the object you want by clicking on it in the list, then click on the first black dot next to its description turning this
into a red X. By doing so, you'll notice that the object disappears in the canvas. This is how the visibility is set to 'OFF'
without actually deleting the object.
Attach
Selecting the 'Attach' dot will cause any object (eg. a balloon) to be attached to the scene. 'Attaching' an object will stick
this to the background image  such that the coordinates (left, top) of the object will be relative to image and not the
canvas.

Note : The 'visibility' and 'attach' properties are not available with audio objects.

See also
Insert extra time
Transition per object
Marks
Adjust Playback speed

Delete/Erase Selection
Transition per scene
Equalize Scenes

Home > Timeline > Adjust Playback speed
Adjust Playback speed
To adjust the playback speed of a specific selection in the Timeline, hold down the CTRL key and place the Playhead at the
selection's ending point. Your selection will be denoted on the Timeline by a green colored area. To speedup the playback,
decrease the size of this area. To slowdown playback drag rightwards, as displayed below, increasing the length of this new
area.
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See also
Insert extra time
Transition per object
Marks
Hide/Attach/Lock Object
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Home > Transformations
Transformations
A transformation modifies a movie’s properties over time. For example, if you want to slowly scale up your movie, you add a
transformation on the scene, then modify the Scale property in the 'Transformation Properties' panel.
Transformations are represented in the Timeline with a shaded rectangle.
A transformation may be added either manually or automatically. To add manually, first, click the Add Transformation button
in the Transformations panel, then adjust the individual parameters: rotation on x,y and z, scale, and zoomnpan. If you don't
wish to keep pressing the 'Add Transformation' button, you may enable the Automatic Keyframing option to add these for you
as you use your mouse.
Transformations cannot be added onto a blank scene. The scene must first be created by either recording the screen or by
importing an existing image or video file.
Listed below are explanations for each option found in the 'Transformations properties' panel.
1

Toolbar
The toolbar contains the following buttons : 'Play'(preview your transformation), 'Copy past values'(restore defined values
from previous transformations), 'Reset'(clear all values)

2

Rotate
Choose your desired values on the x,y, and z axis, respectively.

3

Spin
Rotate your image 360 degrees on the x,y, and z axis, respectively.

4

Scale
Scale your image either up or down.

5

Transparency
Modify the transparency of your image.

6

ZoomnPan
The ZoomnPan feature allows you to focus your audience's attention on key aspects of your recording.
Drag the 'Zoom' slider to select the zoom percentage this will select the percentage of the original image that is to be
displayed after.
Use the Pan tool to drag the image to the particular location you wish to showcase.
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Clicking the individual labels will display a menu which offers the option to either 'Reset' the parameter or copy the specific
parameter's values to all Transformations ('Apply to all' or 'Apply from here to end' depending on required needs)

Automatic Keyframing

Duration

Mouse Functions

Context Menu
See also
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Home > Transformations > Automatic Keyframing
Automatic Keyframing

Enabling 'Automatic Keyframing' allows you to add a new transformation with only the use of the mouse. 'Automatic
Keyframing' is ON when the square shape appears beside the cursor symbol above the Timeline (in the top left side of the
cursor symbol)
Example :
Let's suppose that you want to add a Transformation, during the third second, that rotates the image on the Yaxis and then
scales it. To do this, follow these steps:
1

Position the Playhead at the third second.

2

Click on the image, hold down the right mouse button and then move the mouse horizontally to rotate the background
image on the Yaxis.

3

To scale the image frontwards or backwards use only the mouse wheel.

Check the Timeline afterwards to see that a new Transformation has been added. You may further tweak this transformation by
adjusting the transformation's individual properties as found in the 'Transformations' panel.
See also
Duration
Context Menu

Mouse Functions

Home > Transformations > Duration
Duration
You are able to see the duration of a Transformation by looking on the Timeline.
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1

Position
This position represents the place on the Timeline where the Transformation ends.

2

Duration
The duration of a Transformation defines how long the transition is in effect for.

See also
Automatic Keyframing

Mouse Functions

Context Menu

Home > Transformations > Mouse Functions
Mouse Functions
Transformation properties may be modified with only the use the mouse and CTRL key as follows below.

Move

Press and hold the left mouse button and move
the mouse.

Rotate X/Y

Press and hold the right mouse button and move
the move the mouse horizontally/vertically in
order to modify the rotation on the Y/Xaxis.

Scale

Use the mouse wheel to scale up or down the
image.

Zoom In/Out

Press and hold the CTRL key, then use the
mouse wheel to zoom in or zoom out the image.

Pan

Press and hold the CTRL key, then press and
hold the left mouse button to pan the image.

See also
Automatic Keyframing
Context Menu
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Home > Transformations > Context Menu
Context Menu
To bring up the context menu, rightclick on a Transformation on the Timeline. This feature allows functions such as 'Delete' and
'Equalize Transformations' in terms of duration.
1

Delete Transformation
Select this option to delete the particular transformation.

2

Equalize Transformations(duration)
Use "equalize transformations" to apply the duration from the current transformation to all transformation from the same
scene.

See also
Automatic Keyframing

Duration

Mouse Functions
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Home > Interactivity
Interactivity
Learn how to use Demo Builder's interactive objects to interact with your end user.
Note: These options are only available for movies exported as a Flash Movie (*.swf) .

Edit Zone

Button

Click Zone

Events  Example
See also
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Home > Interactivity > Edit Zone
Edit Zone
Edit Zone objects are extremely useful in creating high quality presentations and tutorials as they allow twoway interactivity
between your movie and your endusers. For example, in conjunction with Demo Builder's other objects, you can use an Edit
Zone to hold the correct answer to a question that you want to ask your users.
At movie runtime, the user will be presented with the question and the movie will pause, awaiting the user's response to be

db11

Interactivity . 101

typed into the Edit Zone.
Demo Builder will then check the user's response against the correct answer as specified by you when you built the movie.
Demo Builder then offers Events ('On Pass', 'On Error', 'On RollOver' as described below) which determine the next action (or
path) taken by the movie.
Set the following properties and options for Edit Zones:

1

Name
The default name for an Animated Text Area is 'Text Animation X' ('Text Animation 1', 'Text Animation 2', 'Text
Animation 3', and so onward), and this is visible in the name property of the object. You can change a text animation's
name by deleting the default name and typing in another one. Ensure the text animation is selected before attempting to
change its name property.

2

Rotate, Scale and Location
Adjust the rotational angles, scale or manually change the location of the Edit Zone on the Canvas. Rotations on the X
and Yaxis are ignored when the edit zones is attached to the image.
Learn more...
Click the Reset button to clear all values.
Click on the individual labels and select Reset to clear the
corresponding value or select Apply to all if you want to apply
your chosen values to all other Edit Zones.

3

Style
The style property allows you to change the appearance (style and color) of the Edit Zone. The default style is 'Classic'.
Learn more...

Note: Demo Builder version 5.0 introduces an additional Edit Zone style  'Transparent'. You might use an Edit Zone with
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a transparent border style when you want it to blend in (invisibly) with the rest of your scene's background image. You
could then use the new 'On RollOver' Edit Zone event (see below) to display a message (in a balloon or text) to your
users when they position the mouse cursor over your 'transparent' Edit Zone.
4

Correct Entries
The correct entries property is were you specify the list of correct responses expected from your users. When a user
enters text and presses the defined Shortcut key on the keyboard (either Enter or Tab), Demo Builder checks the user's
response against the correct list of entries and takes the action for the 'On Pass' event or the 'On Error' event as
appropriate.
Learn more...
To enter the correct entry (or list of correct entries) expected from your users in
order to trigger the actions contained in the 'On Pass' event, click the plus (+)
icon and enter the correct response(s). From the Correct Entries properties
panel, you can choose whether users' responses must be Case Sensitive to
match. Likewise, by checking the Password box, you can choose for user
responses to be displayed hidden as asterisks (*) rather than the actual
characters typed by the user.
Demo Builder can also check your users' responses characterbycharacter.
Check the Check as you type box to activate this feature.
Either Enter or Tab can be used as the Shortcut Key to accept and validate
your users' inputs. Select your choice from the dropdown box.
To remove an entry from the list, simply select it and click the minus () icon.
To change the Text font style of the Edit Zone, click on the text icon which will
display the font wizard and allow you to customize as desired.

Using the Edit Zone Object Events
As described above, you can use Edit Zone Events to interact with the users of your demonstration or tutorial and totally control
the behaviour of your movie based on responses and entries made by your users. The Edit Zone object offers the following 3
events that can be used to achieve this.

1

On Pass Event
Add objects, actions and/or audio to this event to define how your movie will display and behave in response to a correct
answer from your user.

2

On Error Event
Add objects, actions and/or audio to this event to define how your movie will display and behave in response to an
incorrect answer from your user.

3

On RollOver Event
Add objects, actions and/or audio to this event to define how your movie will behave when the user positions the mouse
cursor over the Edit Zone object. (For example to display an explanatory message or tip in a balloon or text as to the
type of response required from the user).
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Important: Each individual Event has its own Timeline to define the separate sequencing of display and behaviors for that event.
Adding Actions and/or Audio to control the behavior of Edit Zone Object Events.

For each of the above events, you can assign the desired behaviour of your movie by adding an Action to take and/or Audio to
be played.
To add (or edit) the action to take or audio to be played for a certain Edit Zone object event, ensure that the Edit Zone object
is selected in your movie scene. This Edit Zone's individual TimeLine will be shown at the bottom of the screen. Click on the
event to which you want to add an action and/or audio and note that the Edit Zone properties panel (at top of screen) will
change to show additional options. The following options are available to be added or edited for Edit Zone events : Stop Movie
, Loop Movie, Close Movie, Go To URL, Run EXE,Go To Movie, Execute JavaScript
For further information on how to incorporate Demo Builder Events and user interactivity into your movies, demonstrations and
tutorials, please see this fully worked Example .

Note: Users of earlier versions of Demo Builder may be familiar with Error and Success Messages. Demo Builder version 5.0
introduces fully featured Event functionality that provides additional user interactivity and total control over the behavior of your
movie in response to user actions. This builds on and replaces the Error and Success Messages functionality of previous versions
of Demo Builder.

See also
Button

Click Zone

Events  Example

Home > Interactivity > Button
Button
Use Button objects in your scenes to pause your demonstration or tutorial and require action from the user in order to continue.
Set the following properties and options for Buttons:

1

Name
The default name for a Button is 'Button X' ('Button 1', 'Button 2', 'Button 3', and so onward), and this is visible in the
name property of the object. You can change a button's name by deleting the default name and typing in another one.
Ensure the button is selected before attempting to change its name property.
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2

Rotate, Scale and Location
Adjust the rotational angles, scale or manually change the location of the button on the Canvas. Rotations on the X and
Yaxis are ignored when the button is attached to the image.
Learn more...
Click the Reset button to clear all values.
Click on the individual labels and select Reset to clear the
corresponding value or select Apply to all if you want to apply
your chosen values to all other buttons.

3

Style
The style property allows you to change the appearance of the button object. The default style is 'Classic'. A new button
style, 'Soft,' has been added in version 5.0 which provides a very smooth and professional looking button for your
scenes.
Learn more...

4

Text
The text property allows you to customize font, font size, font color, text alignment and to also edit the text that is visible
on the button. Doubleclick the body of the button to change the button's text.

Using the Button Object Events
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You can also use 'Button Events' to interact with the users of your demonstration or tutorial and to control the behaviour of your
movie based on your users' actions. The Button object offers the following events to achieve this.

1

On Press Event
Add objects, actions and/or audio to this event to define how your movie will display and behave when your users click
this Button.

2

On RollOver Event
Add objects, actions and/or audio to this event to define how your movie will behave when the user positions their mouse
cursor over the Button object. (For example, to display an explanatory message or tip in a balloon or text as to the action
required from the user).

Important: Each individual Event has its own Timeline to define the separate sequencing of display and behaviors for that event.
Adding Actions and/or Audio to control the behavior of Button Object Events.

For each of the above events, you can assign the desired behavior of your movie by adding an Action to take and/or Audio to
be played.
To add (or edit) the action to take or audio to be played for a certain Button object event, ensure that the Button object is
selected in your scene. This Button's individual Timeline will be shown at the bottom of the screen. Click on the event to which
you want to add an action and/or audio and note that the 'Button properties' panel (at top of screen) will change to show
additional options. The following options are available to be added or edited for Button events : Stop Movie , Loop Movie,
Close Movie, Go To URL, Run EXE, Go To Movie, Execute JavaScript.
For further information on how to incorporate Demo Builder Events and user interactivity into your movies, demonstrations and
tutorials, please see this fully worked Example .

See also
Edit Zone

Click Zone

Events  Example

Home > Interactivity > Click Zone
Click Zone
A 'Click Zone' is another object that allows twoway interactivity between your movie and your endusers. Use a Click Zone in
a scene to pause your Demo/Tutorial and require your that your users click a prespecified zone on the screen in order to
continue (or take some other action).
At movie runtime, the user will be presented with your Click Zone and the movie will pause, awaiting the user's action (click).
Demo Builder then offers Events ('On Click Inside', 'On Click Outside', 'On RollOver' as described below) which determine the
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next action (or path) to be taken by the movie.
Set the following properties and options for Click Zones:

1

Name
The default name for a Click Zone is 'Click Zone X' ('Click Zone 1', 'Click Zone 2', 'Click Zone 3', and so onward), and
this is visible in the name property of the object. You can change a click zone's name by deleting the default name and
typing in another one. Ensure the click zone is selected before attempting to change its name property.

2

Rotate, Scale and Location
Adjust the rotational angles, scale or manually change the location of the click zone on the Canvas. Rotations on the X
and Yaxis are ignored when the click zone is attached to the image.
Learn more...
Click the Reset button to clear all values.
Click on the individual labels and select Reset to clear the
corresponding value or select Apply to all if you want to apply
your chosen values to all other click zones.

3

Hand Cursor
Change the mouse pointer to a hand cursor when a user positions the mouse pointer over the Click Zone.

4

Style
The style property allows you to change the appearance (style and color) of the Edit Zone.
Learn more...
Border Color
Determines the color for the Rectangle's edges.
Border Width
Change the thickness of the Rectangle's edges.
Fill Color
Used to specify a color for the Rectangle.
Fill Opacity
Adjust the transparency of the chosen color.
Eraser
Makes the click zone fully transparent and the borders invisible.

5

Trigger(event)
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Select 'OnClick', 'OnDblClick' or 'OnRightClick' event.

Using the Click Zone Object Events
As described above, you can use Click Zone Events to interact with the users of your demonstration or tutorial and to control
the behavior of your movie based on your endusers actions. The Click Zone object offers the following 3 events to achieve this:

1

On Success Event
Add objects, actions, effects and/or audio to this event to define how your movie will display and behave in response to
your users clicking inside the borders of the Click Zone.

2

On Failure Event
Add objects, actions, effects and/or audio to this event to define how your movie will display and behave in response to
your users clicking outside the borders of the Click Zone.

3

On RollOver Event
Add objects, actions and/or audio to this event to define how your movie will behave when users positions their mouse
cursor over the Click Zone object. (For example to display an explanatory message or tip in a balloon or text as to the
action required by the user).

Important: Each individual Event has its own Timeline to define the separate sequencing of display and behaviors for that event.
Adding Actions and/or Audio to control the behaviour of Click Zone Object Events.

For each of the above events, you can assign the desired behavior of your movie by adding an Action to take, an Effect to
show and/or Audio to be played.
To add (or edit) the action to take or audio to be played for a certain Click Zone object event, ensure that the Click Zone
object is selected in your movie scene. This Click Zone's individual TimeLine will be shown at the bottom of the screen. Click on
the event to which you want to add an action and/or audio and note that the Click Zone properties panel (at top of screen) will
change to show additional options. The following options are available to be added or edited for Click Zone events : Stop
Movie, Loop Movie, Close Movie, Go To URL, Run EXE,Go To Movie, Execute JavaScript.
For further information on how to incorporate Demo Builder Events and user interactivity into your movies, demonstrations and
tutorials, please see this fully worked Example .

See also
Edit Zone

Button

Events  Example
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Home > Interactivity > Events  Example
Events  Example
Let's say that you want to use Demo Builder Events to add user interactivity to your movie, demonstration or tutorial and/or
define how it behaves based on different user actions. Below is a worked example based on a simple situation.
We have created scenes in our tutorial explaining our subject and at this point we want to ask the user a question (or questions)
to ascertain their level of comprehension of the concepts covered in the previous scenes. (For the purpose of the exercise, we'll
assume that the actual question text is contained in a separate Balloon or Text object that has already been inserted into this
scene).
In this example, we'll illustrate Demo Builder's Events and User Interactivity functionality through the use of an Edit Zone object,
but note that the principles are the same for other interactive objects (e.g. Buttons and Click Zones ).
Let's proceed as follows :
1

From the object toolbar, select the Edit Zone object.

2

Click on the Scene's canvas to insert the Edit Zone object at the desired position on the scene. (Set style and format as
desired and as described in the object's help topic  or just leave these settings as default).

3

Enter the correct answer to your question by clicking on the Correct Entries settings tab ('thumbs up' icon) in the Style
Properties panel (top of screen) and typing in the correct answer. (Set other options or properties as or if desired).

4

At this point, you will note that the TimeLine panel (at the bottom of the screen) has changed to include additional
buttons for the events that apply to the selected object and for which Actions and/or Audio can be added or edited
based on users' response(s).(In the case of the Edit Zone object, the applicable events available are 'On Pass', 'On Error'
and 'On RollOver'. See the help topic for the relevant Object you want to work with to see the applicable events
available for that object.)

5

In the TimeLine panel, click on the OnPass button to add actions and audio for this event of the Edit Zone object. i.e.
The behaviour(s) that you want the movie to follow when the user answers your question correctly.

6

You will note that the TimeLine is now empty. Please also note that each individual event has its own TimeLine so that
you may precisely define and control the separate sequencing of display and behaviours for that event.

7

From the Event Actions settings tab (next to the Correct Entries settings tab at the top of the screen), select the action
that you would like the movie to take in the event of a correct answer from the user. In this example, we'll choose
'Continue' to have the rest of the scene or movie continue playing.

8

Add the text "Congratulations, you answered correctly!" in a note to be displayed to the user by selecting the Note
object (from the object toolbar) and inserting it onto the scene's canvas in the desired position.

9

We would also like to add an audio clip of applause to be played when the user answers correctly. Select the Audio
settings tab (next to the Event Actions settings tab at the top of the screen).

10

Click on +/Audio Collection and choose the Applause sound clip from the catalogue of audio clips included as standard
with Demo Builder. Click on OK ('tick') to add this sound to the event. (Voiceover narration could also be recorded
just as easily here to be played when an event is triggered).

11

We're done! Preview the movie and adjust any settings (or timings) as desired.

The above is just one brief example to illustrate the functionality available and get you started with Demo Builder's Events and
User Interactivity. We're sure that as you progress, you'll not only find a myriad of applications for this functionality, but discover
its usefulness in creating professional movies, demonstrations and tutorials that your users will obtain real benefit from.
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See also
Edit Zone

Button

Click Zone
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Home > Add voiceover narration
Add voiceover narration
Learn how to add voiceover narration to your movie by recording this at capture time, preview time or by personally narrating
the Timeline.

Narrate Timeline

Record at capture time

Record at preview time

Insert audio per scene

Builtin audio editor
See also
Welcome

Introduction

Create new movie

Record the screen

Movie

Scenes

Cursors
Character

Tools
Timeline

Transformations

Interactivity

Security

Auto

Export

Miscellaneous

Extras

FAQ

Contact

Home > Add voiceover narration > Narrate Timeline
Narrate Timeline
Narrate the movie using the playback in the preview window as your guide. The audio clip created appears on the Timeline
when the voice narration ends. The recording will automatically stop when the movie reaches the end of your selection or the
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end of the scene.

See also
Record at capture time

Record at preview time

Insert audio per scene

Builtin audio editor

Home > Add voiceover narration > Record at capture time
Record at capture time
In order to be able to record voice narration at capture time, the 'Record VoiceOver Narration' option (denoted by the
microphone symbol) must be enabled.

See also
Narrate Timeline

Record at preview time

Insert audio per scene

Builtin audio editor

Home > Add voiceover narration > Record at preview time
Record at preview time
To record audio while previewing your movie, go to Thumbnails View and select from the movie's properties panel the Audio
Property. Click the + (plus) sign and select the 'Record' menu item. Next, it is important that you press 'Yes' when the dialogue
box appears.
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See also
Narrate Timeline

Record at capture time

Insert audio per scene

Builtin audio editor

Home > Add voiceover narration > Insert audio per scene
Insert audio per scene
Use Audio Editor property panel to record or import audio clips.
Click on the '+' to add audio or the '' to remove a selected audio clip.
Click on the Audio Settings button (at top right) to change audio settings or to select and calibrate your audio input
device.
Each individual audio clip can be edited and tailored to your specific needs.
Click on the button next to the audio clip to be edited. The Audio Clip Editor will be shown.

See also
Narrate Timeline

Record at capture time

Record at preview time

Builtin audio editor

Home > Add voiceover narration > Builtin audio editor
Builtin audio editor
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Adjust volume, insert silence, edit mistakes or add an external audio file to a presentation with the builtin audio clip editor.

See also
Narrate Timeline

Record at capture time

Record at preview time

Insert audio per scene
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Home > Security
Security
Restrict the accessibility of a movie to a specific domain, indicate the latest date by which a movie may be viewed or password
protect your movies.
Note: These options are only available for movies exported as a Flash Movie (*.swf) .

Domain lock

Expiration date

Password protect
See also
Welcome

Introduction

Create new movie

Record the screen

Movie
Cursors

Scenes
Tools

Character

Timeline

Transformations

Interactivity

Add voiceover narration

Auto

Export

Miscellaneous

Extras

FAQ

Contact

Home > Security > Domain lock
Domain lock
Tick the 'Domain Lock' check box to restrict the accessibility of a movie to a specific domain. Then enter the domain's address.
The Domain Lock prevents a movie from being hosted on a domain other than what's specified in this field. If a user tries to
access the movie on a domain other than the one specified, the flash movie will display a message with the 'Display Text' option,
or it will redirect the user to a web page specified in the 'Redirect option'.
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Note: This option is only available for movies exported in Flash, H264 or HTML5 format.
See also
Expiration date

Password protect

Home > Security > Expiration date
Expiration date
Add an expiration date to your movies after which they will no longer play. If a user attempts to view a movie that has expired,
they will be redirected to a webpage or displayed text of your choosing.

Note: This option is only available for movies exported in Flash, H264 or HTML5 format.
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See also
Domain lock

Password protect

Home > Security > Password protect
Password protect
Add password protection to your movies. This option allows you to create movies that will ask the user for a password prior to
playing. If you need the user to log in on the Internet, select 'Server Script' and enter in the URL of the login page. Demo Builder
will send the appropriate parameters to the server script (php, asp ...etc.). See sample code below.

Ask Password  Server Script
Input: username , password
Output: valid=true  The password is valid , valid=false  Invalid password
The following php code allows the movie to continue if password is "test".
<?php
$password = $_REQUEST['password'];
$username = $_REQUEST['username'];
if ( $password == "test" ) { echo "valid=true";} else { echo "valid=false";};
?>

Note: This option is only available for movies exported in Flash, H264 or HTML5 format.

See also
Domain lock
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Home > Auto
Auto

Auto functions reduce the time spent editing by automatically adding balloons, text and the zoomnpan feature to your movie.

AutoText

AutoHighlight

AutoInteract

AutoZoom

AutoRotate

AutoAnimate

Reset Timeline
See also
Welcome

Introduction

Create new movie

Record the screen

Movie

Scenes

Cursors

Tools

Character

Timeline

Transformations

Interactivity

Add voiceover narration

Security

Export

Miscellaneous

Extras

FAQ
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Contact

Home > Auto > AutoText
AutoText
During recording Demo Builder captures relevant information about your actions. 'AutoText' then automatically adds balloons
or texts describing these actions.
1

Add Balloons
Select this option to add balloons attached to the image.

2

Add Texts
Select this option to add text that can be located on the left or right side of the canvas, aligned to the bottom of the canvas
or attached to the image under the mouse cursor.

3

Language
Select the language in which you would like the text to be displayed in.

4

Reader Profile
Select "words per minute" in the reader profile. This option adjusts the amount of time each balloon or text item is
displayed for during the movie.

5

TextToSpeech
Select this option to convert the text into speech.

6

Add 'Click To Continue' button
Select this option to add a "click to continue" button. This option will pause the movie until the user clicks the button to
continue.

7

Make space in the Timeline
Select this option to allow Demo Builder to adjust the Timeline as required for the reader to be able to read the text
displayed. In the case that you do not choose this option, it is likely that the text shown will be out of tune with the movie.
It is not recommended to select this option if your scene contains a voiceover naration recorded at capture time.

db11

Auto . 119

See also
AutoHighlight

AutoInteract

AutoZoom
AutoAnimate

AutoRotate
Reset Timeline

Home > Auto > AutoHighlight
AutoHighlight
Autohighlight adds rectangles or "hand" animations to highlight the areas which you clicked on during capture time.
1

Add Rectangles
Select this option to add rectangles over areas which you clicked on during capture time.

2

Add 'Hand' Animations
Select this option to add "hand" animations which point, from the right, to the area you clicked on during capture time.

3

Duration
Enter the number of seconds that you want your rectangles or animations to last.

4

Make space in the Timeline
Select this option to allow Demo Builder to adjust the Timeline as required for the reader to be able to read the text
displayed. In the case that you do not choose this option, it is likely that the text shown will be out of tune with the movie.
It is not recommended to select this option if your scene contains a voiceover narration recorded at capture time.
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See also
AutoText

AutoInteract

AutoZoom

AutoRotate

AutoAnimate

Reset Timeline

Home > Auto > AutoInteract
AutoInteract
AutoInteract adds click zone areas which will ask the user to click on the areas that you yourself clicked on during recording.
This is a GREAT feature for any training purposes.
1

Add instructional notes
Used to instruct the user to click on the right spot.

2

On Success Event
Select this option to show a positive message when the user correctly clicks inside the click zone area.

3

On Failure Event
Selection this option to show a negative message when the user incorrectly clicks outside the click zone area.

4

On Rollover Event
Selection this option to show a message when the user moves the mouse over the click zone.

5

Hand Cursor
Change the mouse pointer to a hand cursor when the user positions the mouse pointer over the click zone.
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6

TextToSpeech
Select this option if you want to convert the text into speech for all messages above.

See also
AutoText

AutoHighlight

AutoZoom

AutoRotate

AutoAnimate

Reset Timeline

Home > Auto > AutoZoom
AutoZoom
AutoZoom adds Transformations which zoomnpan the image in order to draw your audience's attention to what is most
important.
1

Zoom
Select the amount (measured in terms of percent) of the original image to be shown.

2

Animate
Select the animation level. The 'follow cursor' option (at one extreme of the spectrum) attempts to always center the
cursor within the image.

3

Adjust Scale
Select this option to let Demo Builder choose the best scale. When doing this Demo Builder always attempts to prevent
any undesired stretching of the image.

4

Add Border

db11

122 . Auto

Add a border to your image. A border is useful to distinguish the image from the background of the movie.

See also
AutoText

AutoHighlight

AutoInteract

AutoRotate

AutoAnimate

Reset Timeline

Home > Auto > AutoRotate
AutoRotate
AutoRotate adds Transformations which rotate the image according to your mouse movements.
1

Rotate Y
Select this option to rotate the image on the Yaxis. Drag the slider to determine the maximum rotational angle.

2

Rotate X
Select this option to rotate the image on the Xaxis. Drag the slider to determine the maximum rotational angle.

3

Animate
Select the animation level. The 'follow cursor' option (at one extreme of the spectrum) attempts to constantly rotate the
image wherever the cursor moves.

4

Adjust Scale
Select this option to assure that the image always remains within the Canvas.

5

Add Reflection
Select this option to add a reflection effect to the image.
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See also
AutoText

AutoHighlight

AutoInteract

AutoZoom

AutoAnimate

Reset Timeline

Home > Auto > AutoAnimate
AutoAnimate
Use the AutoAnimate option to to allow Demo Builder to automatically create movement and speech for your Character
according to your movie.
1

Walk
Selecting this option will add walking animations to the Timeline with regard to cursor movement. You can also select
how closely a Character follows the cursor by adjusting the slider under Walk, although if the distance is too small a Walk
movement will not be automatically added.

2

Speak
During recording, Demo Builder will identify what actions the mouse was used for in a program, when selecting Speak it
will automatically compose and add the appropriate texts (e.g. click this button). Click the Person icon next to the Speak
option to select a voice installed on your computer, which your character will use for the automatically added Textto
Speech.

3

Head
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This option will add head movement animations to the Timeline, these movements are added according to when the
cursor clicks on something (i.e. a Character's head movement will follow cursor movements that end in a click). You can
also adjust the Speed and Flexibility of the head movement using the sliders below the Head option.
4

Mimic
Demo Builder recognizes which actions the cursor performs during screen recording and will add Mimic animations
accordingly. For example, when the cursor selects an item from a menu the Character will perform the "Select" Mimic
animation.

5

Adjust Scale
Select this option to assure that the image always remains within the Canvas.

6

Add Reflection
Select this option to add a reflection effect to the image.

See also
AutoText

AutoHighlight

AutoInteract
AutoRotate

AutoZoom
Reset Timeline

Home > Auto > Reset Timeline
Reset Timeline
Click the Reset Timeline menu item to delete all objects and transformations. Resetting the Timeline will also restore the
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original length (timing) as established at capture time. This is helpful if you are testing any AutoFunctions features. For example,
imagine that you had added Balloons with the AutoText function and then decided that you no longer desired these. Resetting
the Timeline will eliminate these and restore the original values.

Note: This operation cannot be undone.

See also
AutoText

AutoHighlight

AutoInteract
AutoRotate

AutoZoom
AutoAnimate
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Home > Export
Export
Demo Builder offers multiple Build and Export options for your movies. Save, Share and Distribute in multiple formats to make
sure that you get your message across to the widest audience possible.

Format

Destination
See also
Welcome
Create new movie

Introduction
Record the screen

Movie
Cursors

Scenes
Tools

Character

Timeline

Transformations
Add voiceover narration

Interactivity
Security

Auto
Extras

Miscellaneous
FAQ

Contact

Home > Export > Format
Format
Demo Builder allows you to export movies in the following file formats : Flash, MP4Flash Player, MP4HTML5 Player, Audio
Video Interleave, Windows Media Video, MPEG4 , Standalone, Image Files and Word Document.

Flash

MP4Flash Player
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MP4HTML5 Player

Audio Video Interleave

Windows Media Video

MPEG4

Google WebM

Standalone

Image Files

Word Document

Help me choose

See also
Destination

Home > Export > Format > Flash
Flash
Flash is an extremely popular format for playing animated video, particularly over the internet. The Flash player plugin is installed
in virtually all internet browsers, so this format is widely compatible with PC and Macs.
Exporting in Flash format actually creates two separate files: a SWF file and a HTML file. The SWF (Flash) file is your actual
movie, the HTML file is a web page that will display your movie. Once you export in Flash Movie format, you should upload all
files to your web server, thus publishing your movie on the internet.
1

SWF  File Name
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Enter flash(.swf) file name. You do not need to include the filename extension (.swf).
Flash Options...
You should select the first option (JPEG Compression) if you created your
movie by importing image files. Doing so will render the best quality movie
possible, however, the size of the Flash file will also consequently increase.
The second option is recommended in the case that your movie was
created using either the 'Take screen shot' or 'FullMotion recording'
method.
Select Grayscale if would like to render your movie in grayscale.

2

HTML
This option exports the HTML code necessary to add a Flash(.swf) file to a web page.

3

HTML  File Name
Enter html file name. You do not need to include the filename extension (.html).
Edit HTML Content
You are free to edit the HTML content however you see fit (to
display the movie within a custom HTML web page of your
choosing).
However, the HTML file also contains the following special code
that should not be altered:
<!NAME>
<!STYLE>
<!SCRIPT>
<!MOVIE>

4

HTML  Color
Select the background color of the page.

5

HTML  Adjust Size
You can change the size of the flash movie to fit your specifications. Moreover, you may choose to have the flash movie
fit the browser window or you can specify new dimensions.
Note: Please understand that there are differences between 'movie resizing' and 'html movie resizing'. The 'html movie
resizing' option attempts to stretch the movie to comply with the dimensions specified, while also maintaining the previous
aspect ratio. However, this option may distort your movie if drastically downscaling.

6

Learning Management System
Select this option if you want to upload your movie to an LMS. (e.g. Moodle)
Demo Builder is fully compliant with SCORM 1.2/2004 and AICC Learning Management Systems.
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Check the 'Zip Files' box to compress all the files into a single zip file.
e.g. moviename_aicc.zip, moviename_scorm12.zip, moviename_scorm2004.zip

SCORM Manifest file
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See also
MP4Flash Player

MP4HTML5 Player

Audio Video Interleave
MPEG4

Windows Media Video
Google WebM

Standalone
Word Document

Image Files
Help me choose

Home > Export > Format > MP4Flash Player
MP4Flash Player
The MP4(H264)Flash Player format is setting the standard for video files played on the internet due to its added image clarity
and reduced file size. This format is thus recommended for movies of a longer length.
Exporting in this format brings multiple advantages, such as: a progressive download feature (the movie is loaded while playing),
compatibility with the iPad, iPod and iPhone.
That being said, using this format does partially reduce interactivity. In other words, the buttons, edit zones and click zones can
no longer capture mouse or keyboard inputs, although all of the StartEnd properties are still available if a HTML/SWF player is
attached (see below). Should you want a fully interactive movie, the Flash format is still the best.
Note: Those running Windows XP or Vista must have Apple QuickTime installed on their machines to export in this format.
However, once the movie is exported, the enduser does not require Apple QuickTime to view the movie.
1

MP4  File Name
Enter MP4 file name. You do not need to include the filename extension (.mp4).
H264 Options...
Video Quality
Select the video quality. A higher quality will increase the resulting file size.
Adjust Size
You can adjust the size of the movie to fit your specifications.
No Audio
Selecting this option will eliminate all audio from your movie
Note: Please understand that there are differences between 'movie resizing'
and the above option. This option attempts to stretch the movie to comply
with the dimensions specified, while also maintaining the previous aspect
ratio.

2

HTML
This option creates three additional files: a SWF file and a HTML file. The SWF (Flash) file is used to play the mp4 file,
the HTML file is a web page that will display your movie. Once you export in this format, you should upload all
files(mp4,html,swf) to your web server, thus publishing your movie on the internet.
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3

HTML  File Name
Enter html file name. You do not need to include the filename extension (.html).
Edit HTML Content
You are free to edit the HTML content however you see fit (to
display the movie within a custom HTML web page of your
choosing).
However, the HTML file also contains the following special code
that should not be altered:
<!NAME>
<!STYLE>
<!SCRIPT>
<!MOVIE>

4

HTML  Color
Select the background color of the page.

5

HTML  Adjust Size
You can change the size of the flash movie to fit your specifications. Moreover, you may choose to have the flash movie
fit the browser window or you can specify new dimensions.
Note: Please understand that there are differences between 'movie resizing' and 'html movie resizing'. The 'html movie
resizing' option attempts to stretch the movie to comply with the dimensions specified, while also maintaining the previous
aspect ratio. However, this option may distort your movie if drastically downscaling.

6

Learning Management System
Select this option if you want to upload your movie to a LMS. (e.g. Moodle)
Demo Builder is fully compliant with SCORM 1.2/2004 and AICC Learning Management Systems.
Check the 'Zip Files' box to compress all the files into a single zip file.
e.g. moviename_aicc.zip, moviename_scorm12.zip, moviename_scorm2004.zip

SCORM Manifest file
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Note: The video's dimensions will be adjusted as follows: in H264 format the dimensions must be divisible by a factor of 16.
Demo Builder will automatically adjust your movie's size if it does not comply with the above specifications.
See also
Flash
Audio Video Interleave

MP4HTML5 Player
Windows Media Video

MPEG4
Standalone
Word Document

Google WebM
Image Files
Help me choose

Home > Export > Format > MP4HTML5 Player
MP4HTML5 Player
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Export in MP4(H264)HTML5 Player format is recommended if you would like your movie to be viewed on an iPad or iPhone.
That being said, the export in this format actually allows your movie to be viewed on any device, including PCs, Macs, tablets,
and cellphones.
Using this format does partially reduce interactivity. In other words, the buttons, edit zones and click zones can no longer
capture mouse or keyboard inputs, although all of the StartEnd properties are still available. Should you want a fully interactive
movie, the Flash format is still the best.
Note: Those running Windows XP or Vista must have Apple QuickTime installed on their machines to export in this format.
However, once the movie is exported, the enduser does not require Apple QuickTime to view the movie.
1

MP4  File Name
Enter MP4 file name. You do not need to include the filename extension (.mp4).
MP4 Options...
Video Quality
Select the video quality. A higher quality will increase the resulting file size.
Adjust Size
You can adjust the size of the movie to fit your specifications.
No Audio
Selecting this option will eliminate all audio from your movie

Note: Please understand that there are differences between 'movie resizing'
and the above option. This option attempts to stretch the movie to comply
with the dimensions specified, while also maintaining the previous aspect
ratio.

2

HTML
This option creates four additional files: html5 file, html5db.js, html5db.css, html5db.png. The last three files are common
and can be shared by any movie exported in HTML5 format. Once you export in this format, you should upload all 5
files(mp4, html5 file, html5db.js, html5db.css, html5db.png) to your web server, thus publishing your movie on the
internet.

3

HTML  File Name
Enter html file name. You do not need to include the filename extension (.html).
Edit HTML Content
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You are free to edit the HTML content however you see fit (to
display the movie within a custom HTML web page of your
choosing).
However, the HTML file also contains the following special code
that should not be altered:
<!NAME>
<!STYLE>
<!SCRIPT>
<!MOVIE>

4

HTML  Color
Select the background color of the page.

5

HTML  Adjust Size
You can change the size of the flash movie to fit your specifications. Moreover, you may choose to have the flash movie
fit the browser window or you can specify new dimensions.
Note: Please understand that there are differences between 'movie resizing' and 'html movie resizing'. The 'html movie
resizing' option attempts to stretch the movie to comply with the dimensions specified, while also maintaining the previous
aspect ratio. However, this option may distort your movie if drastically downscaling.

6

Learning Management System
Select this option if you want to upload your movie to a LMS. (e.g. Moodle)
Demo Builder is fully compliant with SCORM 1.2/2004 and AICC Learning Management Systems.
Check the 'Zip Files' box to compress all the files into a single zip file.
e.g. moviename_aicc.zip, moviename_scorm12.zip, moviename_scorm2004.zip

SCORM Manifest file
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Note: The video's dimensions will be adjusted as follows: in H264 format the dimensions must be divisible by a factor of 16.
Demo Builder will automatically adjust your movie's size if it does not comply with the above specifications.
See also
Flash

MP4Flash Player

Audio Video Interleave

Windows Media Video

MPEG4

Google WebM

Standalone

Image Files

Word Document

Help me choose

Home > Export > Format > Audio Video Interleave
Audio Video Interleave
This option is particularly useful for exporting movies of longer length. It is also recommended if you intend to publish your movie
on video sharing websites, such as YouTube and Metacafe or if you want to import the video file in a video editing software.
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AVI is a popular video file format. Each AVI file is encoded with a 'codec' (such as DivX or Cinepak) that compresses the
video data on export and decompresses it for viewing in movie playing software. When you export in AVI format, you will also
have to pick a codec to encode with from the list of those installed on your PC.
1

File Name
Enter the video file name. You do not need to include the filename extension(.avi).

2

Adjust Size
You can adjust the size of the movie to fit your specifications.
Note: Please understand that there are differences between 'movie resizing' and the above option. This option attempts to
stretch the movie to comply with the dimensions specified, while also maintaining the previous aspect ratio.

3

No Audio
Selecting this option will eliminate all audio from your movie.

See also
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MP4Flash Player

MP4HTML5 Player

Windows Media Video

MPEG4

Google WebM

Standalone

Image Files
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Word Document

Help me choose

Home > Export > Format > Windows Media Video
Windows Media Video
This option is particularly useful for exporting movies of longer length. It is also recommended if you intend to publish your movie
on video sharing websites, such as YouTube and Metacafe.
WMV format is commonly used for movie playback on Windows PCs. The software required to playback WMV files is
installed on most Windows PCs.
1

File Name
Enter the video file name. You do not need to include the filename extension(.wmv).

2

Adjust Size
You can adjust the size of the movie to fit your specifications.
Note: Please understand that there are differences between 'movie resizing' and the above option. This option attempts to
stretch the movie to comply with the dimensions specified, while also maintaining the previous aspect ratio.

3

No Audio
Selecting this option will eliminate all audio from your movie.
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Note: Depending on the option chosen, the video's dimensions will be adjusted as follows: in WMV format the dimensions must
be divisible by a factor of 2. Demo Builder will automatically adjust your movie's size if it does not comply with the above
specifications.

Embedding a wmv file in your web page
Embedding a video file is achieved by inserting a block of code in the web page's HTM. The example below shows the code for
embedding a Windows Media file. Note that it uses two tags: <object> and <embed>. This is to enable maximum browser
compatibility.You will need to set the file name (and other attributes if required) for both tags. Use true or false for the
<object> tag, 1 or 0 for the <embed> tag.
To get started, all you have to do is copy the code below into your web page and replace 'mymovie.wmv' with your own file
name.
<OBJECT ID="MediaPlayer" WIDTH="800" HEIGHT="600" CLASSID="CLSID:22D6F312B0F611D094AB
0080C74C7E95"
STANDBY="Loading Windows Media Player components..." TYPE="application/xoleobject">
<PARAM NAME="FileName" VALUE="mymovie.wmv">
<PARAM name="autostart" VALUE="false">
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<PARAM name="ShowControls" VALUE="true">
<param name="ShowStatusBar" value="false">
<PARAM name="ShowDisplay" VALUE="false">
<EMBED TYPE="application/xmplayer2" SRC="mymovie.wmv" NAME="MediaPlayer"
WIDTH="800" HEIGHT="600" ShowControls="1" ShowStatusBar="0" ShowDisplay="0" autostart="0"> </EMBED>
</OBJECT>

See also
Flash

MP4Flash Player

MP4HTML5 Player

Audio Video Interleave

MPEG4

Google WebM

Standalone

Image Files

Word Document

Help me choose

Home > Export > Format > MPEG4
MPEG4
This option is particularly useful for exporting movies of longer length. It is also recommended if you intend to publish your movie
on video sharing websites, such as YouTube and Metacafe.
MP4 can be played back on Windows PCs that have the QuickTime player, which is often installed with iTunes. They can also
be played back on virtually all Macs, but the format is not widely compatible with Linux.
1

File Name
Enter the video file name. You do not need to include the filename extension(.mp4).

2

Adjust Size
You can adjust the size of the movie to fit your specifications.
Note: Please understand that there are differences between 'movie resizing' and the above option. This option attempts to
stretch the movie to comply with the dimensions specified, while also maintaining the previous aspect ratio.

3

No Audio
Selecting this option will eliminate all audio from your movie.
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Note: The video's dimensions will be adjusted as follows: in MPEG4 format the dimensions must be divisible by a factor of 16.
Demo Builder will automatically adjust your movie's size if it does not comply with the above specifications.

See also
Flash

MP4Flash Player

MP4HTML5 Player

Audio Video Interleave

Windows Media Video

Google WebM

Standalone

Image Files

Word Document

Help me choose

Home > Export > Format > Google WebM
Google WebM
This option is particularly useful for exporting movies of longer length. It is also recommended if you intend to publish your movie
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on video sharing websites, such as YouTube and Metacafe.
1

File Name
Enter the video file name. You do not need to include the filename extension(.webm).

2

Adjust Size
You can adjust the size of the movie to fit your specifications.
Note: Please understand that there are differences between 'movie resizing' and the above option. This option attempts to
stretch the movie to comply with the dimensions specified, while also maintaining the previous aspect ratio.

3

No Audio
Selecting this option will eliminate all audio from your movie.

Note: The video's dimensions will be adjusted as follows: in WebM format the dimensions must be divisible by a factor of 2.
Demo Builder will automatically adjust your movie's size if it does not comply with the above specifications.

See also
Flash

MP4Flash Player
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MP4HTML5 Player

Audio Video Interleave

Windows Media Video

MPEG4

Standalone

Image Files

Word Document

Help me choose

Home > Export > Format > Standalone
Standalone
Demo Builder exports an executable file that runs on Windows PCs to display the movie. It requires no extra software to be
installed on a PC and is compatible with Windows 2000 and above, but it will not run on Mac OS X or Linux.
1

File Name
Enter the standalone file name. You do not need to include the filename extension.

2

Title
Enter the window's title.

3

Full Screen
Check this option to execute running the application in full screen mode.

4

Create autorun for CD
AutoRun is a feature of the Microsoft Windows operating system. When users insert an AutoRunenabled compact disc
into their CDROM drive, AutoRun automatically runs an application on the CDROM. This option creates an
'autorun.inf' file that has to be burned on the CD along with the standalone file.

db11

Export . 143

See also
Flash

MP4Flash Player

MP4HTML5 Player

Audio Video Interleave

Windows Media Video

MPEG4

Google WebM

Image Files

Word Document

Help me choose

Home > Export > Format > Image Files
Image Files
Exporting in 'Image Files' format creates a sequence of image files. Optionally, you can also export an html file in order to
display all of the images within a web page.
1

Scenes
Specifies the specific scenes that need to be exported.

2

Include hidden scenes
Check this option to include hidden scenes.
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3

Objects
Specify the objects that need to be included in a scene.

4

Method
Specify the method of generating the file names of the images.
'Automatic File Name' or 'Use Scene Name as File Name'

5

Prefix
Enter the file name prefix if the method is : 'Automatic File Name Format'

6

Format
Specify the format for all images.
BMP(Windows Bitmap), JPG(JPEG Image File), GIF(CompuServe GIF), PNG(Portable Network Graphics)

7

Size
Specify the size of the images.
Maintain Aspect Ratio, Reset To Original Size : set image size to movie size

8

Export HTML
This option exports a html file in order to display the image files within a web page.

9

HTML Style
Specifies the style in which you want to display the images.
'One image per page' or 'All images on page'

10

HTML File Name
Enter the html file name. You do not need to include the filename extension (.html).
Click '<>' button to edit the HTML content. The HTML file contains html code with the following special tags :
<% MOVIE NAME%>  Your Movie's Name  and  <%IMAGE FILES%>  An array of images
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See also
Flash

MP4Flash Player

MP4HTML5 Player

Audio Video Interleave

Windows Media Video

MPEG4

Google WebM

Standalone

Word Document

Help me choose

Home > Export > Format > Word Document
Word Document
You can also publish your project in 'Microsoft Word DOC' format which will display your slides on printable pages in the
format of your choosing. Choose to include cursor movements, text boxes and even blank lines so that students can take notes.
Great for handouts !
1

Scenes
Determine the specific scenes that need to be exported.

2

Include hidden scenes
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Check this option to include hidden scenes.
3

Objects
Specify the objects that need to be included in a scene.

4

File Name
Enter the document(.doc) file name. You do not need to include the filename extension (.doc).

5

Frames per page
Rows by Columns

6

Elements
'Scene Name', 'Blank lines for notes', 'Captions', 'Scene Notes'

Note: Please note that Microsoft Word 2003 or later must be installed on your machine.

See also
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Google WebM

Standalone

Image Files

Help me choose

Home > Export > Format > Help me choose
Help me choose
The best format to choose depends on the end purpose and audience of your movie.
SWF MP4 AVI WMV MPEG4 WEBM EXE
High quality
Small file size
Characters
Interactive objects
iPad, iPhone
YouTube
Suitable for the Internet
Limit(minutes)

1520 None None None None

None

1520

1. Flash(SWF)
In general, the best option is Flash format. Compared to other formats, Flash is advantageous in several regards: a smaller file
size, high quality playback, allows enduser interactivity.
Flash is an extremely popular format for playing animated video, particularly over the internet. The Flash player plugin is installed
in virtually all internet browsers, so this format is widely compatible with PC and Macs.
However, you should be aware that exporting in Flash format also has its drawbacks. We only recommend the export in Flash
format option if your movie is less than 20 minutes in length and a maximum of 8 minutes per scene.
More indepth explanation from Adobe :
http://kb2.adobe.com/cps/144/tn_14437.html
That being said, if your movie is longer than the recommended length for exports in Flash format yet you wish to export this in
Flash format, it is still possible to do so — please see the link below to find out exactly how this can be done. In general, we
advise that you do not create one overly long movie — instead, try to divide your movies into smaller 'sections' or 'chapters'.
These smaller, individual movies can then be 'linked' together to give the appearance of a single movie if so desired.
How to link your movies together to give the appearance of a single movie
2. MP4  Flash Player  recommended for longer movies
For movies that are longer than 20 minutes, the export in MP4Flash Player format option is often a better choice compared to
Flash. The drawback is that MP4 does not allow for enduser interactivity.
3. MP4  HTML5 Player  recommended for longer movies, iPad, iPhone
The above two options both employ Flash to playback your movie. Since Flash is not supported on iOS devices, you must
export in MP4HTML5 Player format if your movie will be watched on an iPad or iPhone. The export in this format also allows
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your movie to be watched on any device, including PC, Macs, tablets, and cellphones.
The drawback is that interactivity is not supported. The export process will create one video file, which is played using the
VIDEO tag in HTML5.

See also
Flash

MP4Flash Player

MP4HTML5 Player

Audio Video Interleave

Windows Media Video

MPEG4

Google WebM

Standalone

Image Files

Word Document

Home > Export > Destination
Destination

You can specify three destinations for your chosen file format : Save To Disk, Upload to FTP Server, Send To EMail.

Save To Disk

Upload To FTP Server

Send EMail
See also
Format

Home > Export > Destination > Save To Disk
Save To Disk
Export your movie to your local hard drive.
1

Location
Click the Browse icon and select the location on your hard drive or disk where the file is to be saved.

2

Desktop
Click the Desktop icon to select the desktop as the saving location.

db11

Export . 149
3

Export in folder
When selecting this option, Demo Builder will create a special folder for each export type. For example, it will create the
folder \My Movie\Flash\ if you export in Flash format or \My Movie\HTML5\ in you export in HTML5 format.

4

Show summary upon export
Select this option to receive a report, after export is completed, containing the resulting file’s size and dimensions.

See also
Upload To FTP Server

Send EMail

Home > Export > Destination > Upload To FTP Server
Upload To FTP Server
Upload your movie to your website.
FTP Server

db11

150 . Export
1

Server
Enter the address for the FTP server. (e.g. hostname.com or 02.352.67.162)
You can get this information from your ISP (Internet Service Provider) OR from the web server's administrator.

2

Port
This is the port to connect to on the FTP website. This is normally 21, however, it may be something different if you are
going through a firewall, or if the site administrator has assigned the FTP service to a nonstandard port.

3

Path
Enter the destination path for the file.

4

Passive Mode
Passive transfers are necessary for some firewall and gateway configurations and when you get failed data channel errors.

5

Username and Password
In the Username and Password boxes, enter the username and password assigned to you by the ISP or server
administrator of the FTP site.

6

Proxy
The Proxy and Port fields are not mandatory.

After Upload
1

URL prefix
Enter a URL prefix which will be used when creating the full URL.

2

Copy URL to Clipboard
Select this option to copy the URL to the clipboard. You will hear a distinct sound confirming the copy to the clipboard.

3

Open in the default browser
Select this option if you would like the URL to be opened in your default browser once upload is completed.
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See also
Save To Disk

Send EMail

Home > Export > Destination > Send EMail
Send EMail
Send movie through email using an email client installed on your computer or an SMTP server.
1

Use
Select one of the following options: Outlook, Outlook Express, Lotus Notes or SMTP server.
If you select SMTP server, click the Configuration button in order to enter SMTP server details.

2

Recipient
Enter the recipient's email address.

3

Subject
Enter the default subject title.

4

Body
Type your intended message for the recipient or leave the default message.

5

Zip Files
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Select this option to zip all files and send the zip file via email as attachment.

See also
Save To Disk

db11

Upload To FTP Server

Miscellaneous . 153

Home > Miscellaneous
Miscellaneous

Personalize

TextToSpeech

Preferences

Keyboard Shortcuts
See also
Welcome

Introduction

Create new movie

Record the screen

Movie
Cursors

Scenes
Tools

Character

Timeline

Transformations

Interactivity

Add voiceover narration

Security

Auto

Export

Extras

FAQ

Contact

Home > Miscellaneous > Personalize
Personalize
Immediately after recording your movie, a window (as seen below) appears giving you the opportunity to personalize your
movie. Make sure that Show the Personalize' Wizard Upon Capture option is selected in the Preferences window. Similarly,
you may also choose this option by rightclicking in the Thumbnails view and selecting the 'Personalize' menu item.
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Please note that all of the following options can also be selected during the editing phase.

See also
TextToSpeech

Preferences

Keyboard Shortcuts

Home > Miscellaneous > TextToSpeech
TextToSpeech
Demo Builder does not come with any preinstalled voices. Demo Builder actually makes use of the voices already installed on
your machine. Depending on your operating system, you can choose from a variety of these.
Demo Builder also functions with voices acquired and installed from outside sources. We recommend those from ivona.com.
When exporting in Flash or Video format the speech is captured as a sound file. 'TexttoSpeech' is not required on the
computer used to view the final presentation.

See also
Personalize

Preferences

Keyboard Shortcuts

Home > Miscellaneous > Preferences
Preferences
The Preferences window contains five tabs : General, AutoCalculate, TextToSpeech,Confirmation Messages and Defaults.
General Tab
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1

Check for update at startup
Verify automatically that you are using the most uptodate version of Demo Builder! Tick this box to check if any
updates are available when Demo Builder starts (recommended).

2

Show the 'personalize' wizard upon capture
Quickly personalize your movie by using 'Auto functions' insert a introduction scene,a ending scene, autotext and
more.

3

Grid
Using for lining up images, cursors, notes and balloons within your movie's scenes.

4

Progress Window
The Progress Window displays as your movie is being built.
Pin : The progress window continues to display after Demo Builder completes compiling and stands ready to play the
movie.

5

Spelling Options
Demo Builder can check spelling and grammar errors according to your language specification. You can use more than
one language dictionary. Simply tick the relevant option box(es) as desired.

AutoCalculate Tab
1

AutoCalculate Size
You can use this option to have Demo Builder automatically estimate how large the text boxes (e.g. notes and balloons)
should be.

2

AutoCalculate Time
You can use this option to have Demo Builder automatically estimate how long each text box (e.g. notes and balloons)
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should be displayed in the Timeline. This is based on the "words per minute" reader profile.

TextToSpeech Tab
1

Voice
Click on this combination box to change the default voice.

2

Volume
Determine volume. (0100)
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Confirmation Message Tab
When a box is checked from the list of options, Demo Builder will ask for confirmation of the corresponding actions when
necessary.
Example:
From the Preferences Wizard, Confirmation Messages tab, ensure that the 'Delete scenes' option is checked.
Then click on a Scene within your movie and press the Delete key on your keyboard.
Demo Builder displays a confirmation message.
Click 'Yes' to confirm or 'No' to leave the scene in your movie.
If you check the box 'Don't Show Again', the Delete Scenes option in the preference wizard is autounchecked and
Demo Builder will not request confirmation of this action until you recheck this in your preference wizard.
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Defaults Tab
1

Font
Set the default font name and size.

2

Style
Set the default balloon, note, edit zone and button style.

3

Duration
This sets the default duration a new Scene or Object will be displayed for during a movie. For example, if the initial
interval in preferences is set to 3 seconds, it means that objects you insert in your movies' scenes will be displayed for 3
seconds when the movie runs. You can adjust this default time manually in the Timeline.
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See also
Personalize

TextToSpeech

Keyboard Shortcuts

Home > Miscellaneous > Keyboard Shortcuts
Keyboard Shortcuts
The following Keyboard Shortcuts are available throughout Demo Builder :
Key

Action

CTRLO
CTRLS
F10
F11
CTRLZ
SHIFT
CTRLZ
CTRLC
CTRLV

Open Project
Save Project
Export Project
Share Movie
Undo
Redo
Copy object or scene
Paste object or scene
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Del
CTRLA

Delete object or scene
Select all objects or scenes

F5
ENTER
F8
F9
F6
F7

Home(see all scenes)
Edit Scene
Preview Scene(s)
Preview Movie
Previous Scene
Next Scene

B
N
T
X
R
L
F
P
H
C
E
U
Z
A
V
O
S
K

Insert Balloon
Insert Note
Insert Text Area
Insert Animated Text
Insert Rectangle
Insert Ellipse
Insert Image (from file)
Insert Image (from cliparts)
Insert Image (take screenshot)
Insert Cursor
Insert Edit Zone
Insert Button
Insert Click Zone
Insert Animation
Insert Flash Video
Insert Zoom Area
Insert Blur Area
Insert Hotkey

When playing a movie the following PlayerBar keyboard shortcuts are available :
Key

Action

Home
Space
Left Arrow
Right Arrow
M
I

Back to First Scene
Pause/Play
Previous Scene
Next Scene
Audio On/Off
Info

See also
Personalize
Preferences

db11

TextToSpeech

Extras . 161

Home > Extras
Extras
These additional tools are found by clicking on the Extras menu item from the main menu.

Aggregator

Upload To Could Storage

Upload To YouTube

SWF To Video Converter
See also
Welcome

Introduction

Create new movie

Record the screen

Movie

Scenes

Cursors

Tools

Character

Timeline

Transformations

Interactivity

Add voiceover narration
Auto

Security
Export

Miscellaneous

FAQ

Contact

Home > Extras > Aggregator
Aggregator
With Aggregator you can link together multiple swf, flv, or mp4 files. The resulting file will include a table of contents, on the left
side of the window, playing your movies one after another, just as you'd like. The Aggregator can export the resulting file in
either Flash or EXE file formats.
To launch the Aggregator tool, select from the Demo Builder main menu 'Extras', and then the 'Aggregator' menu item.The user
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interface contains two tabs : 'Playlist' and 'Customize'.

Playlist Tab
To add items click the 'plus shaped' button. You can give a caption and file name to each item. Click the 'Browse' bottom to
select a file, or simply enter the file's name in the corresponding field. Click the 'Submenu' item in order to create your Table of
Contents (seen as a 'tree'). To remove an item, click the 'minus shaped' button or press the 'Delete' key.To change the order of
the items, drag and drop as needed.
Drag & drop files  the easiest way to add items !
You can easily add items from your desktop directly to your Aggregator project.
Customize Tab
The file generated by the Aggregator is composed of several elements : Menu level 1, level 2 ,level 3 | and | Item title, spacer
, and video area. By selecting one of these elements, you may customize its properties using the top panel. When none of these
elements are selected, you can then change the general settings of the Aggregator: dimensions, page color, border color, drop
shadow, and autoplay(the next movie will be played in descending order, one after another). Clicking on the 'Dimensions' label
will bring up a window where the Aggregator's size and video's position can be further edited. The dimensions in which the
movie will be displayed is calculated automatically, and displayed in red in the top right hand side (of the video area). Movies
which do not fit in the given dimensions will have their original dimensions reduced, maintaining the same aspect ratio, to fit the
needed dimensions.
Should you like, you can add a default set of 'customizations' by rightclicking on an empty space and selecting "Set as default".
From the same popup menu, clicking 'Reset' will rollback to the default settings.
Please note that the dimensions in design time do not correspond to those used in the generated file (e.g. the menu's width never
changes). These dimensions are only used for operative purposes.

Exporting your Aggregator project
The file generated by the Aggregator may be exported in one of two formats: Flash or EXE format. The file(s) exported by the
Aggregator will be placed in the same folder as your '.aggregator' file. That being said, you must save the project (the
'.aggregator' file) before you can export this. To export, click 'File' on the menu bar, 'Export', and then choose the format
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desired. You may also use the hotkeys F9 (Flash format) or F10 (EXE format). When exporting in Flash, three files will be
generated: HTML,SWF, and JS file. When exporting in EXE format, only a single EXE file will be created.
Important: The resource files which the Aggregator uses (calls upon) must be located alongside in the same folder as the files
exported by the Aggregator tool. For example, in the above screenshot, the files 'intro.mp4', 'takescreenshots.swf', and
'fullmotion.swf' must all be located in the same folder as the files exported by the Aggregator tool.
Should this condition not be met, the Aggregator will display the following message "URL not found!".
Start playing a particular item, as specified
By default, the Aggregator will start playing the first item should the 'AutoPlay' option be selected. However, there may also be
cases where you need the Aggregator to begin by playing an item other than the first one listed (in the corresponding 'tree' view).
In this case, you have two options:
1

URL Parameter
http://domain.com/myaggregatorfile.html?startindex=xxx

2

Using FlashVars
FlashVars="startindex=xxx"
To read more about FlashVars, click here.

Where 'xxx' represents the tree item's number (in descending order, beginning at the top). The first item in the 'tree' view has a
'1' startindex value. For example, in the screenshots above, the 'Take screen shots' item has a '3' startindex value, 'Full motion' a
'4', and so forth.

See also
Upload To Could Storage

Upload To YouTube

SWF To Video Converter

Home > Extras > Upload To Could Storage
Upload To Could Storage
With Upload to Cloud Storage tool, you can upload your movies to DropBox, GoogleDrive or SkyDrive.
To launch the Upload To Cloud Storage tool, select from the Demo Builder main menu 'Extras', followed by the 'Upload To
Cloud Storage' menu item. You can also click the 'Share' button from the Thumbnail View.
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If you click the 'Share' button from the Thumbnail view, Demo Builder will build the mp4 file of your current movie. Once
completed, you will be able to select the desired cloud storage location.

Once uploading is complete, a link (to download, share or view) will be provided to you to the uploaded movie.

See also
Aggregator

Upload To YouTube

SWF To Video Converter

Home > Extras > Upload To YouTube
Upload To YouTube
With Upload to YouTube tool, you can upload your movies to YouTube.
To launch the Upload To YouTube tool, select from the Demo Builder main menu 'Extras', followed by the 'Upload To
YouTube' menu item. You can also click the 'Share' button from the Thumbnail View.

If you click the 'Share' button from the Thumbnail view, Demo Builder will build the mp4 file of your current movie. Once
completed, you will be able to “YouTube” as the desired destination.
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Once uploading is complete, the following will be provided to you: (depending on selection)
a view link to the YouTube video OR
the html code needed to embed the YouTube video into your html page

See also
Aggregator

Upload To Could Storage

SWF To Video Converter

Home > Extras > SWF To Video Converter
SWF To Video Converter
With SWFToVideo tool, you can convert your swf files created by Demo Builder to video format.
To launch the SWFToVideo tool, select from the Demo Builder main menu 'Extras', and then the 'SWFToVideo' menu item.

Once you have finished recording your swf file, you can export it in AVI, MP4 or WMV format. You may then modify the
corresponding options as necessary. Moreover, you may also upload the video to YouTube directly from the SWFToVideo
converter.

See also
Aggregator

Upload To Could Storage

Upload To YouTube
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Home > FAQ
FAQ

The 'FAQ' section includes answers to common questions, 'tips and tricks' and solutions to difficulties that users have previously
encountered.

Record

Edit

Export

Interactivity

License

See also
Welcome

Introduction

Create new movie

Record the screen

Movie

Scenes

Cursors

Tools

Character
Transformations

Timeline
Interactivity

Add voiceover narration

Security

Auto

Export

Miscellaneous

Extras

Contact

Home > FAQ > Record
Record
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The Webroot Secure Anywhere application prevents Demo Builder from recording the screen. To avoid and/or
resolve this issue, you will need to configure Webroot as follows:
1

Open Webroot Secure Anywhere Complete. (Start>All Programs>Webroot SecureAnywhere folder>Webroot
SecureAnywhere icon.)

2

Click the Identity and Privacy tab on left.

3

Click on the "View/Edit Applications" link.

4

Scroll until you see Demo Builder listed.
This can be found under "db.exe" in "C:\Program files (86)\Demo Builder 10\".

5

You will see three columns, "Protect", "Allow", or "Deny".
Each column has buttons you can use to make your selection.
In the row where Demo Builder is listed, click on the button in the "Allow" column.

6

Click close when done.

7

Close Webroot, since you are done.

8

Restart Demo Builder.

See also
Edit
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Home > FAQ > Edit
Edit
How do I remove the 'info' button from the PlayerBar?
The PlayerBar Information button can be removed (hidden) from your frame/movie by clicking on the PlayerBar button in the
movie's properties panel. Deselect the Info Button checkbox.

How can I change the details shown in the movie's 'info' panel?
Go to the Thumbnails View of the movie. In the Movie Properties bar, click on the double downward pointing arrows button to
the immediate right of the movie's title. This will open a panel in which you can enter the details you want shown in the 'info'
panel.

Can users pause my movie during playback? How?
With Demo Builder's PlayerBar, your users can have full control of the movie's playback (e.g. Pause/Play, Stop, Rewind).
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What is 'Preloader'?
If you export a movie with 'Preloader' checked, the movie will load fully before it commences playing.
To employ this feature, check the 'Preloader' button from the StartEnd options in the Movie Properties panel.

How do I get the mouse cursor to change to the 'hand' when over a Click Zone?
Select the relevant Click Zone object and click on the Hand Cursor button on the Click Zone Property panel (top of screen).

Can I translate my movie captions for international distribution?
New in Demo Builder Version 5.0, the Localize Wizard allows you to update the language in your movies for international
distribution. Use the Localize Wizard to export your movies' caption text (found in balloons, notes, text boxes and so forth) to a
Word Document, update this with text in the desired language and then import it back into your movie. Start by selecting
"Localize" from Demo Builder's File menu to bring up the Localize Wizard and then follow the wizard's simple steps.

What is AutoCalculate Time/Size?
Two additional options for objects have been introduced in Demo Builder Version 5.0 to make it even easier to create
professional looking demonstrations and tutorials quickly.
1

AutoCalculate Size
Automatically size your text area to fit the amount of entered text.

2

AutoCalculate Time
Automatically adjust the timing in the Timeline based on the 'Reading Speed' property in Preferences.

See also
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Export
Is the Adobe Flash Player plugin required to view my demos(Flash format)?
The Adobe Flash Player plugin is required to view a SWF file. Please note that the browser will automatically try to download
and install this if it is not already present. The user will only have to confirm the installation of the plugin.
Almost 99% of browsers already have the Adobe Flash Player installed.
See this survey for more information : http://www.adobe.com/products/player_census/flashplayer/
What is needed to distribute my movies? On the web? On CD?
To share your movies over the web, you will need the SWF file and the HTML file that was created along with it.
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To distribute the movies on CD, you will need the EXE file and (optionally) the 'autorun.inf' file that were created when the
movie was exported in Standalone format. The autorun.inf file is only required if you want the movie to play automatically when
the CD is inserted into the drive.
For movies burned to CD, how do I add 'autoplay' so that movie playback starts automatically when the CD is
inserted in the player?
When you export and burn a movie to CD in Standalone format, check the 'Create autorun' for CD option. The movie will be
created along with a file named 'autorun.inf' that you must include on the CD with the movie (*.exe) file in order for the movie to
start automatically upon insertion in the CD drive.
Produced H264/SWF Flash plays on local computer, but not from server.
You may need to update the server's MIME types to support the MP4 format. The following instructions walk through
configuring IIS and Apache for the MP4 MIME type.
Internet Information Services (IIS) 7
1

Open IIS Manager

2

Click on the computer name of the server

3

Double click on MIME Types.

4

Select Add from the right and enter in Extension: .mp4 and MIME Type: video/mp4.

5

Right click on Default Web Site > Stop.

6

Right click on Default Web Site > Start.

Internet Information Services (IIS) 6
1

Open IIS Manager

2

Access computer name of the server > HTTP Headers > MIME Types.

3

Click on New and enter in Extension: .mp4 and MIME Type: video/mp4.

4

Right click on Default Web Site > Stop.

5

Right click on Default Web Site > Start.

Apache
1

Locate and open Mime.types file (normally contained within /etc/httpd/conf/) in an text editor.

2

Add a new line to this file of video/mp4 .mp4

3

Save file and restart Apache.

See also
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Home > FAQ > Interactivity
Interactivity
How do I create a transparent button?
A transparent button can be a simple Click Zone object. You should activate the 'Hand Cursor' to indicate to the user where the
button is located and that some action is available or required from him or her.
How do I play audio when an event occurs?
Each of Demo Builder's interactive objects (Button, Click Zone, Edit Zone ) have events that are triggered by users' actions. To
play audio when these events occur, simply select the relevant interactive object and follow these steps:
1

From the TimeLine (bottom of screen), select the event that the audio is to be added to and choose when this will be
played. (For example, the On Pass event of the Edit Zone object).

2

Add the desired audio clip to be played within the event in the same manner as you add audio to a frame. (See here for
further details).

3

Repeat as desired for any other events/objects.

4

Preview, test and amend if necessary.

Note: Each individual Event has its own TimeLine to define the separate sequencing of display and behaviours for that event.
See also
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License
Can demonstrations and tutorials that I have created with a fully licensed version of Demo Builder be sold and
freely distributed by me?
Any exported movies, demonstrations, tutorials and so forth that you have made with a fully licensed version of Demo Builder
are considered to be your own (intellectual) property. You are free to sell and/or distribute your own exported works as you
desire.
I just purchased Demo Builder. How do I get the program and install it?
To install the full version of Demo Builder, please follow these steps:
1

Go to the customer area and enter the email and the password you received at the time you purchased Demo Builder.

2

Download the program and license key file. Remember to put both files in the same folder after downloading them.

3

Begin the setup process and follow the instructions on screen.
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I have purchased the full version. Will I still be able to use the samples I have already created?
The movies, demonstrations and tutorials that you have created with a trial version of Demo Builder will still be fully usable.
Opening and reexporting these samples with a fully licensed version of Demo Builder will also remove the watermark from
these movies.
What do I need to do with license key file ?
You do not have to open or view the product license key file. You must only save it in the same folder as the setup files of the
full version of Demo Builder.
In this manner, Demo Builder's setup process will automatically locate it and you will not be asked for it. Should the product key
not be colocated with the setup files, you will be asked to provide the correct path to the license key file during the installation
process.

See also
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Home > Contact
Contact
Founded in 2000, Tanida Software is an Information Technology company, developing elearning software for home and
office use. Tanida’s clients include thousands of corporate, government, academic organizations and many individual users
worldwide who use their software to quickly create rich, interactive learning content resources. The company currently offers
two premier products, Demo Builder and Quiz Builder, that enable learning professionals and subjectmatter experts to create
elearning tutorials, demos, quizzes and tests.
Web Site

www.demobuilder.com

General Inquiries

info@demobuilder.com

Sales
Customer Support

sales@demobuilder.com
support@demobuilder.com  http://www.demobuilder.com/support.html
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